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Important Setup Information for SOAPware Practice Management

1. Contact GatewayEDI to begin Enrollment Process for submitting electronic claims

2. Each Lesson should be completed in the order they are listed

3. Current users of SOAPware that have already setup maintenance files should check each one for
additional billing information required to complete the setup.

4. Lessons in this Chapter containing information used on the CMS 1500 form will have the block
number from the CMS 1500 form shown in parentheses in the title.

5. If a section of Billing is inaccessible to a user, go to Security setup and check the Billing section for
the User. Security is accessible by logging in to SOAPware as Administrator. 

For complete instructions for security settings click the link to Security Setup Charts: Workshop
Pre-Requisite Manual: Security 

Steps for setting up billing section of security can be found by clicking the link:  Billing Security
Administration
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Getting Setup with Gateway EDI -- What to Expect

A brief description of the Provider Enrollment process.  

(Color coding is used to denote participant roles and associated activities.)
          Blue  = Office
         Teal = SOAPware
         Black = Gateway EDI (GEDI) 

1.    Office purchases and installs SOAPware Clinical Suite and signs up for the following training
sessions in exact order: 

          A.  SOAPware Billing Setup
          B.  Transaction Entry and Workflow
          C.  Claims Processing

2.    Office contacts Gateway EDI (GEDI) and signs a contract with Gateway.  (Note:  This can happen
before installing SOAPware CS.)

3.    Office completes SOAPware master setup and begins practicing with the software in preparation
for live use.  (Note:  This step can be done in conjunction with the steps shown below.)

4.    GEDI will contact the Office to complete a Provider Enrollment online.  GEDI will request provider
ID numbers and Master Insurance List (MIL) from Office; provider enrollment process will begin within
two days of signed contract.

5.  GEDI will generate the Enrollment packet, and the Office is given payer enrollment packet to
complete.

6.    Office returns enrollment packet originals to GEDI and production date is estimated based upon
projected payer approval time frames. 

Estimated average payer approval times, (by state), can be viewed on the attached spreadsheet.

The Office can begin sending commercial claims as each payer approval is granted, followed by
governmental approvals.)

7.    GEDI verifies accuracy and forwards payer enrollment agreements to Carriers. 

8.    GEDI contacts Carriers to obtain approval dates and records dates on addendum. 
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9.    BCBS, Medicare, and Medicaid payer approvals are obtained.  The training packet, which includes
a copy of the Providers Addendum (list of Provider ID numbers and payer approvals), training CD, and
MIL is sent to the Office. 

10. GEDI will contact the Office to schedule an "install appointment."  

IMPORTANT:  BEFORE scheduling install appointment with GEDI, the Office MUST have
attended and completed the training sessions listed in #1 above AND have completed setup of
SOAPware system.

HIGHLY RECOMMENDED:  When the Office is ready to send the first live claim file, (with real patient
claims), SOAPware recommends that the office use a one-on-one training session to provide
assistance from SOAPware PM experts for this first filing.  A SOAPware representative will inspect the
setup of the system to ensure everything looks correct, and will also assist the Office with creating,
scrubbing and troubleshooting the first claim file.  SOAPware will also help the office prepare for their
setup call with GEDI.

11.  Office sends first file with live claims to GEDI; file is tested (two day turnaround) before GEDI
production begins. 

12.  Once the Office is installed and is sending claims, the Office will be contacted to schedule initial
report training. 

13.    Report training is completed. 

14.  Two weeks after production begins, a second report/web training is offered to the Office. 

15.  Two week-stage web training is completed. 

16.  Each office is assigned to a GEDI New Accounts Rep who will monitor their claims for first 30-60
day period in production to ensure that the claims acceptance rate is above 85%. 

17.  Office may request additional phone training with GEDI and/or call/email with Support questions at
any time. 

18.  GEDI Customer Service will work with the Office to correct any errors on claims submitted. GEDI
will always be available for any insurance questions, or other questions about the reports or errors.  
Anything related to the generation of claims files or errors on the software side will be handled by
SOAPware Tech Support via www.soapware.com/ticket
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NOTE: For an estimate on the average amount of time it will take to get approvals with the payers in
your state, please see the attached Excel spreadsheet. 
PLEASE NOTE THAT THIS TIME ESTIMATE BEGINS AFTER GATEWAY HAS RECEIVED YOUR
COMPLETED PROVIDER ENROLLMENT PAPERWORK.  
To help expedite the setup process, Office should submit completed GEDI enrollment forms as
soon as possible.
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1. Manage Facilities (Block 24B and Block 32)

Tools -> Manage Facilities

Facility Manager

Click the Create New Facility button. 
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Setup Facility Details

Steps 1-5 identifies the Place of Service-Block 32 

1. The commonly known Facility Name. 
2. Legal Name of the facility. (block 32)
3. Physical address of the facility. (block 32)
4. City, State and Zip of the facility. (Block 32)
5. Clinic Phone number.
6. NPI number assigned to the facility. (Block 32a)
7. Place of Service this selection specifies the code that is placed on claims (Block 24B) identifying
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the type of facility. 
8. Phone number for Billing Inquiries. This number will appear on Patient Statements, Receipts,
etc. for billing questions
9. Press Update to save 

Practice Management 2010.3 User Manual - 15



2. Manage Groups/Billing Provider/ Pay To Information (Block 33)

Tools menu -> Manage Groups

Manage Groups/Pay To Information 

Click Add Group button to add a new Group/Pay to information. 
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Add a Group

Enter Pay To/Billing Provider information for the Clinic.  Creating a Group and associating a provider
with a Group, will cause the group information to default as the Provider's Pay To/Billing Provider
information, with each insurance company. If there a specific Insurance Company that recognizes a
different Pay To (or Group) for a particular Provider, the Group information can be overridden in the
Insurance Company dialog, as needed.

It is highly recommended that you set up your Groups after your Facilities, as it will greatly streamline
your setup of insurance companies later in the setup process. Note: It is recommended that even if a
Provider in the clinic is his/her own group, you can setup a single provider as a group. The Group
information will be the default Pay To Provider for the Provider. All in all, a group can represent a single
doctor or a group of doctors. It is really just who the billing entity is for the Provider.  

1. Contact Information: Enter the basic demographic information for the group. (Name, Address and
Phone)

2. Tax ID: Enter the appropriate ID for the group. You can indicate either the EIN or social security
number.

3. Submitter ID:  Select Mutually Defined - ZZ for the identifier for the Submitter ID. This ID is how
Gateway EDI knows who is submitting the claim file. The ID field will be your 4 digit Site ID code
provided to you by Gateway EDI.
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4. Legacy ID: (Optional) Select from the drop down to indicate a particular ID/number, if your state
requires a particular ID on every claim. For instance, if your state requires the Taxonomy Code, you
can enter the taxonomy identifier and code, and the information will go in the legacy field of every claim,
along with the NPI number. If you are not aware that a particular ID is required for every claim for your
state and payer base, other than the NPI, you may be able to ignore this field. 

5. NPI: Enter the NPI number that has been assigned to the Group.

6. CLIA ID: (Optional) Enter the CLIA ID into this field, if one has been assigned to your clinic.

7. Click Save when finished.

8. Insurance Information: When setting up a brand new system, you can ingnore the Insurance
Information section, initially. You will have to have your insurance companies setup first, before you can
really take advantage of this field. Once you have finished the setup process, and need to change a
legacy ID to be used for the group, with a particualr insurance company, you can change that
information here at the group level, if needed. 
      - To create a new legacy ID for a specific insurance company (for your group), you will click the
Create New button (with the green + sign). Search for the needed Insurance
         Company. Click Select. Select the Legacy identifier from the drop down box, and enter the
associated code.  Click Save when done.
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Newly added Group/Pay to Provider is added to the List. Most often there will only be a single Provider
or a single group listed here per clinic. A Group can contain one to many Providers, but a Provider can
only be associated with one group. 
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3. Provider Manager (Blocks 24J and 31)

Tools -> Provider Manager

Enter/edit Rendering Provider information, Link Provider to a Group. The Misc. tab will
indicate to Payers that the Selected Group is the Billing/Pay To Provider

1. Click to highlight and Select a Provider from the list. Providers should have been added when
SOAPware was initially installed and licenses were activated. 

2. Enter the Provider's demographic information, including his/her DEA, NPI and Taxonomy numbers. 

3. Click the Misc Tab to assign the Provider to a specific Group.
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4. Click the drop down arrow to display a list of available Groups. Select the appropriate Group from the
dropdown.
5. Click the Update button to save details.
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Signature Tab (Block 31)

The clinician's signature will need to be captured via a signature capture device, scanning in a hand
written signature as a picture, or even using Microsoft Paint. Save the signature in a picture format.

1. Click the Signature tab to insert a signature for the Provider
2. Click the Select Image button to capture the image. Find the location of the stored signature image
and Click on the image. Click Open.
3. The signature will appear within the box provided to preview. If the image needs to be increased in
size, click the + button to zoom in. If the image needs to be made smaller, click the - sign to zoom out.
When first displayed, the image will default to 100% of its actual size.
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4. Click Update to save signature.
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4. Setting Default Claim Options/Base Export Path

Setup how paper and electronic claims are exported from the system.

Tools -> Billing Maintenance -> Claims Options

Paper Claim Options

1. Default Printer: Select from the dropdown to set the default printer when printed paper claims.  

2. Print Full CMS Form: If not using preprinted CMS 1500 form, check Print Full CMS form to print the
entire claim form, including the red lines (must have color printer).
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Electronic Claim Options

1.  *Office Contact: Enter the Contact Name for the person in the office who will be the contact for
Gateway EDI, if any issues arise.

2.  *Office Contact Phone: Enter the Contact Phone Number for the person in the office who will be
the Gateway EDI contact.

3.  Output Path: Specify a file location to which claims will be exported. Note: Make sure that the Save
Local Copy box is checked to save your claim files to a local file. If more than one person in the office
works with claims, it is recommended that this file path be stored in a shared file/drive to allow multiple
people to access the claim files.

4.  Auto Submit: If this box is checked, electronic claim files will be automatically uploaded to the clinic
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Gateway EDI site. You will have to have the correct information entered in the Clearinghouse fields in
the section below to ensure this will work correctly. If you would like to manually save and upload claim
files to Gateway EDI, uncheck this box.

5. Save Local Copy: Check this box if you would like to store a copy of your claim files on a local
drive/file location. If you have Auto Submit and Save Local Copy checked, you will be able to both auto
submit your files to Gateway EDI, and you will have the claim file stored in a local drive, in case any
discrepancy comes up, and the file needs to be re-uploaded.

1. Name: Indicates the name of the Clearinghouse.

2. Clearinghouse ID: If using Gateway EDI as your clearinghouse, enter the following number in this
field: 431420764 
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3. Receiver Qualifier: If using Gateway EDI as your clearinghouse, select Mutually Defined - ZZ from
the dropdown list.

4. Receiver ID: If using Gateway EDI as your clearinghouse, enter the following number: 
431420764000000 

5. User Name: Enter the 4 digit site ID assigned to your clinic by Gateway EDI.

6. Password: This password will be given to you by Gateway EDI. This will be the needed password to
auto submit your claim files using their sftp site.

7. Server: If using Gateway EDI as your clearinghouse, enter the following: sftp.gatewayedi.com

8. Testing: Only check this box if you are wanting to send a test file to Gateway EDI. IMPORTANT: For
your first claim submission to Gateway EDI, do not check this box. Gateway prefers to have live claims
sent to them. They will manually review the file first, and if everything looks good, they will forward on to
payers.

9. Accept Assignment: Check this box if you would like to default to Accept Assignment on all claims.
It can be overriden at the Insurance Company and claim level, if needed.

10. Click Okay to save.
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5. PM Security Administration 

Tools -> Security

Billing Security options have been added for Groups, Roles and Users. Each section will have to be
completed to allow Users access to assigned areas of Billing. Click on a specified action to allow
access (green check mark), deny access (red X) or default to the user's individual privileges (leave
blank ). Clicking on Allow All button will place a check in all boxes and Clicking Deny All will place a
red X in all boxes. 

Users should be added to Security Prior to assigning privileges to Billing

Security changes made will not take effect until you log out. For additional documentation on Security
see SOAPedia online manual
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Assign Billing Security Privileges to Roles

Access to specified sections can be manually allowed or denied for each user.

Another way to assign security privileges to users is to select or create a Role, assign accessibility to
the role, and then assign that Role to a User. This will eliminate the need to go into every section of
billing for each user and repeat the process. 

1. Click on the expander node next to Roles.
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2. Click on the expander node next to one of the Roles in the list. (Screenshot shows Office Manager
selected)

Billing Access

3. Click the expander node next to Billing 

4. Click on Billing

5. Click inside the box next to Accessible-This will allow any user assigned the Role of Office Manager
to access the Billing Menu option
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Adjustment Maintenance 

6. Click the expander node next to Billing Maintenance

7. Double Click Adjustment Maintenance

8.  Click on a specified action to allow access (green check mark), deny access (red X) or default to
the user's individual privileges (leave blank ). Clicking on Allow All button will place a check in all
boxes and Clicking on Deny All will place a red X in all boxes. 

Add code-Allows user to add new adjustment codes in Adjustment Maintenance dialog
Edit code-Allows user to edit adjustment codes 
Inactivate code-Allows user to mark an adjustment code Inactive. 

Repeat Steps 7 and 8 for each section/action under Billing 
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CPT Maintenance

Edit code-Deny access or allow user to Edit CPT Maintenance 
Inactivate code-Deny access or allow user to mark a CPT code Inactive
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Custom Charges Maintenance

Add code-Deny access or allow user to add a Custom Charge code
Edit code-Deny access or allow user to edit a Custom Charge code
Inactivate code-Deny access or allow user to mark a Custom charge Inactive
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Fee Schedule Maintenance

Accessible-Deny access or allow user access to the Fee Schedule menu option 
Add Fee Schedule-Deny access or allow user ability to Add a new Fee Schedule
Edit Fee Schedule-Deny access or allow user ability to make edits within the Fee Schedules
Inactivate Fee Schedule-Deny access or allow user the ability to make a Fee Schedule Inactive
Add Code-Deny access or allow user the ability to Add a new Code from the HCPCS/CPT list to a Fee
Schedule
Update Code Values-Deny access or allow user to Update Code amounts 
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HCPCS Maintenance

Edit code-Deny access or allow user to edit a HCPCS code in Maintenance
Inactivate code-Deny access or allow user to change a HCPCS code to Inactive
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ICD Maintenance

Edit code-Deny access or allow user to edit a Diagnosis code in ICD Maintenance
Inactivate code-Deny access or allow user to change a Diagnosis code to Inactive
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Claim Details

Edit Owner-Deny access or allow user to change Owner/Provider in Charge Details
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Insurance Company Manager

Accessible-Allow/Deny user access to the Insurance Company Master files/Maintenance
Add Insurance Company-Allow/Deny user to add new insurance companies
Update Insurance Company-Allow/Deny user to update/save insurance companies
Remove Insurance Company-Allow/Deny user to delete/remove an insurance company from
Insurance company Maintenance
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Claims Manager

Accessible-Deny access or allow user access to the Claims Manager
Scrub Claim-Deny access or allow user to scrub claims in the Claims Manager
Edit Claim-Deny access or allow user to edit claims in the Claims Manager
Change Claim Status-Deny access or allow user to change the claim status in the Claims Manager
Rebuild Claim-Deny access or allow user to Rebuild a claim in the Claims Manager
Generate Electronic-Deny access or allow user to generate an electronic claims file in the Claims
Manager
Submit Claims-Deny access or allow user to submit claims in the Claims Manager
Print Claims-Deny access or allow user to print claim forms in the Claims Manager
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Insurance Payment

Accessible-Deny access or allow user access to Insurance Payment Posting
Create Payment-Deny access or allow user to Create a new Insurance Payment
Save Claim-Deny access or allow user to apply a payment and save that payment in Insurance
Payment Posting
Post Payment-Deny access or allow user to post a payment in Insurance Payment Posting
Apply Payment Details-Deny access or allow user access to add/edit Payment/Remit details in
Insurance Payment dialog
Print Payment-Deny access or allow user access to Print Payment in Insurance Payment dialog
Change Next Action-Deny access or allow user to edit the Next Action option in Insurance Payment
dialog
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Patient Account

Create New Chart/Patient Account-Deny access or allow user to create a new chart or patient account
Allow Check Self Pay-Deny access or allow user to check the box next to self pay option on patient
account information bar
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Patient Claims

Add On Hold/Claim Notes-Deny access or allow user access to comment in the On Hold notes
section or the Claims Notes section in the Claims Tab
Delete Claim-Deny access or allow user to remove/delete claims in the Claims Tab
Edit Charge-Deny access or allow user to edit charges in the Claims Tab
Edit More Info-Deny access or allow user to edit More Info dialog in the Claims Tab
Select CMS1500-Deny access or allow user to select/view the CMS 1500 claim form from the Claims
Tab
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Patient Family

Add Dependent-Deny access or allow user to add a dependent to a Patient Account Family tab
Make Payment-Deny access or allow user to make a payment in the Patient Account Family tab
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Patient Ledger

Add Charge-Deny access or allow user to add a charge from Patient Ledger
Edit Charge-Deny access or allow user to edit a charge from Patient Ledger
Delete Charge-Deny access or allow user to delete a charge from Patient Ledger
Add Adjustment-Deny access or allow user to apply an adjustment from Patient Ledger
Edit Adjustment-Deny access or allow user to edit an adjustment from Patient Ledger
Delete Adjustment-Deny access or allow user to delete an adjustment from Patient Ledger
Add Payment-Deny access or allow user to add a payment from Patient Ledger
Edit Payment-Deny access or allow user to edit a payment from Patient Ledger
Delete Payment-Deny access or allow user to delete a payment from Patient Ledger
Print Receipt-Deny access or allow user to print a receipt from Patient Ledger
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Patient New Charges

Create Visit-�user to create a new visit in New Charges tab
Delete Visit-Deny access or allow user to delete a visit in New Charges tab
Add Adjustment-Deny access or allow user to add an adjustment to a charge in New Charges tab
Delete Adjustment-Deny access or allow user to delete an adjustment in New Charges tab
Add Payment-Deny access or allow user to add a payment to a charge in New Charges tab
Delete Payment-Deny access or allow user to delete a payment in New Charges tab
Add Charge-Deny access or allow user to add a charge to a visit in New Charges tab
Delete Charge-Deny access or allow user to delete a charge in New Charges tab
Edit Charge Details-Deny access or allow user to edit charge details �
Add More Info-Deny access or allow user access to the More Info dialog in New Charges tab
Mark as Incomplete-Deny access or allow user to mark a charge as Incomplete in New Charges tab
Change Follow-Up Action-Deny access or allow user to change the Follow Up action in New Charges
tab
Enter Claim Comments-Deny access or allow user to enter claim comments to a charge in New
Charges tab
Apply Co-Pay-Deny access or allow user to apply a Co-Pay to a charge in New Charges tab
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Apply Pre-Pay-Deny access or allow user to Apply a Pre-Pay to a charge in New Charges tab
Omit from Statement -Deny access or allow user to omit a charge from a claim in New Charges tab
Post a Visit-Deny access or allow user to Post a Visit to the Ledger from the New Charges tab

Patient Schedule

Select a Scheduplate-Deny access or allow user access to scheduplates in Schedule tab
Add a Referral-Deny access or allow user to add a referral to an appointment in Schedule tab
Change the Status-Deny access or allow user to change an appointment status in Schedule tab
Set a Recurrence-Deny access or allow user to set a recurring appointment for a patient in Schedule
tab
Add a Resource-Deny access or allow user to add a Resource in Schedule tab
Delete an Appointment-Deny access or allow user to delete a scheduled appointment in Schedule tab
Edit Resource-Deny access or allow user to edit a resource in Schedule tab
Enter Visit Comments-Deny access or allow user to enter visit comments in Schedule tab
Check Insurance Verification-Deny access or allow user to check Insurance Verified in Schedule tab
Check in a Patient-Deny access or allow user to check in a patient in Schedule tab
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Take a Co-Pay-Deny access or allow user to take a co-pay in Schedule tab
Create a New Visit-Deny access or allow user to create a new visit in Schedule tab
Print a Visit-Deny access or allow user to print a visit in Schedule tab

Patient Statements

Open Statements-Deny access or allow user access to the Statements tab in Patient Account
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Payer Account

Edit Demographics-Deny access or allow user to edit demographics in Payer/Non-Patient Account
Add Dependent-Deny access or allow user to add a dependent to a Payer/Non-Patient Account
Delete Dependent-Deny access or allow user to delete a dependent in a Payer/Non-Patient Account
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Reports

CPT Master-Deny or allow user access to view/print the following reports from Billing -> Reports menu 
HCPCS Master
ICD Master
Custom Charge Master
Adjustment Master
Fee Schedule Report
Dependency Report
Duplicate Report
Payment Summary
Production By Procedure
Daily Receivable Summary
Statement Report
Outstanding Insurance 
Credit Balance Report
SOAPnote Audit Report
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6. CPT Code Maintenance (Block 24D)

Located in the Tools menu -> Billing Maintenance ->CPT Maintenance

CPT Code Maintenance  
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CPT Search by Code

Begin typing the CPT code in the CPT Look up and as you type, the codes and short descriptions are
listed.

CPT Search by Description

Begin typing the CPT description in the Short Description Look up and as you type, the codes and short
descriptions are listed.

Practice Management 2010.3 User Manual - 51



Create a Custom CPT Description

1. After selecting a CPT code, Place a check mark if you wish to use the custom descriptions when
searching for this code.

2. Begin typing a short description of your choice for this selected CPT code.

Note:  Only complete this section if using descriptions other than the original short descriptions for the
CPT code.

Inactivate a CPT code

To inactivate a CPT Code, place a check mark in the Inactive box. This will not completely remove it
from the data base, but will remove it from the list. See Hide/Show Inactive CPT Codes.
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Hide/Show Inactive CPT Codes

If a code had been Inactivated and is no longer going to be used, it can be hidden when viewing the
Code List by placing a check mark in the Hide Inactive Codes box.

View All CPT Descriptions

To view all descriptions associated with CPT codes in the Code List, Click the radio button next to Full
View. Included in the list will be any Custom Short, Medium or Long  descriptions if the Use Custom
Descriptions is selected when Creating a Custom CPT Description .
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CPT Effective, Modified or Deactivation Date

1. Effective date column lists the year the code is in effect.

2. Modified Date column lists the date the code was last modified.

3. When a CPT code is discontinued Deactivation Date column will list the date it was discontinued
Note: The dates are automatically inserted. 
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7. HCPCS Maintenance (Block 24D)

Tools -> Billing Maintenance -> HCPCS Maintenance

HCPCS Maintenance
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HCPCS Search by Code

Begin typing the HCPCS code in the HCPCS Look up and as you type, the codes and short
descriptions are listed.

HCPCS Search by Description

Begin typing the HCPCS description in the HCPCS Short Description Look up, and as you type, the
codes and short descriptions are listed.
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Create a Custom HCPCS Description

1. After selecting a HCPCS code, Place a check mark if you wish to Use the Custom Descriptions when
searching for this code.

2. Begin typing a short description of your choice for this selected HCPCS code.

Note:  Only complete this section if using descriptions other than the original short descriptions for the
HCPCS code. 

Inactivate a HCPCS code

To inactivate a HCPCS and delete it from the HCPCS Code List, Place a check mark in the Inactive
box. This will not completely remove it from the data base, but will hide it from view if there is also a
check mark in the Hide Inactive Codes option.

Practice Management 2010.3 User Manual - 57



View all HCPCS Descriptions

To view all descriptions associated with the HCPCS codes in the Code list, Click the radio button next
to Full View.  Included in the list will be any Custom descriptions that have been assigned to HCPCS
codes.

HCPCS Add, Effective and Inactive Date

1. Add Date column lists the date the code is added to the data base.

2. Effective Date lists the date the code is in effect.

3. Inactive Date lists the date a code is discontinued or deleted. 

Practice Management 2010.3 User Manual - 58



Hide/Show Inactive HCPCS Codes

If a code had been Inactivated and is no longer going to be used it can be removed from the Code List
by placing a check mark in the Hide Inactive Codes box.
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8. ICD Maintenance (Block 21)

 Tools menu -> Billing Maintenance -> ICD Maintenance

ICD Maintenance
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ICD Search by code

Begin typing the ICD code in the ICD Look up and as you type, the codes and short descriptions are
listed.

ICD Search by description

Begin typing the ICD description in the Short Description lockup and as you type, the codes and short
descriptions are listed.
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Create a Custom ICD Description

1. After selecting a ICD code, Place a check mark if you wish to use the custom descriptions when
searching for this code.

2. Begin typing a short description of your choice for this selected ICD code.

3. Click Save.

Note: Only complete this section if using descriptions other than the original short descriptions for the
ICD code.

Inactivate an ICD code

1. To inactivate a ICD code and delete it from the ICD Code List, Place a check mark in the Inactive
box.

2. Click Save. 

Note: This will not completely remove it from the data base, but will hide it from view if there is also a
check mark in
the Hide Inactive Codes option.

Practice Management 2010.3 User Manual - 62



ICD Effective, Modified and Deactivation Date

1. Effective date column lists the year the code is in effect.

2. Modified Date column lists the date the code was last modified.

3. When an ICD code is discontinued Deactivation Date column will list the date it was discontinued.

Note: The dates are automatically inserted when modified or updated

Hide/Show Inactive ICD Codes

If a code had been Inactivated and is no longer going to be used it can be removed from the Code List
by placing a check mark in the Hide Inactive Codes box.
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9. Adjustment Maintenance

Tools menu -> Billing Maintenance -> Adjustment Maintenance

Adjustment Maintenance
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Add an Adjustment

1. Click on the Green + to open the New Code Section.

2. Type Numeric and/or Alpha Code.

3. Give the new Code a Description.

4. Click the Add button. The new Custom Adjustment code is now added to the Code List.

Inactivate an Adjustment

To inactivate an Adjustment Code and delete it from the Code List, Place a check mark in the Inactive
box. This
will not completely remove it from the data base, but will hide it from view if there is also a check mark in
the Hide Inactive Codes option.
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Adjustment Search by Code

Begin typing the Custom Adjustment code in the Code Search and as you type, the codes and short
descriptions are
listed.

Adjustment Search by Description

Begin typing the Adjustment description in the Short Description Search and as you type, the codes
and short
descriptions are listed.
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Adjustment Effective, Modified or Deactivation Date

1. Effective date column lists the year the code is in effect.

2. Modified Date column lists the date the code was last modified.

3. When an Adjustment code is discontinued Deactivation Date column will list the date it was
discontinued.

Note: The dates are automatically inserted when modified or updated

Hide/Show Inactive Adjustment Codes

If a code had been Inactivated and is no longer going to be used it can be removed from the Code List
by placing a check mark in the Hide Inactive Codes box.
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10. Custom Charges Maintenance

Tools menu -> Billing Maintenance -> Custom Charges Maintenance

Custom Charges Maintenance
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Add a Custom Charge

1. Click the Green + to open the New Code dialog.

1. Type new Code using numeric and/or alpha characters.

2. Type a Short Description for the code.

3. Type a Medium Description. (optional) 

4. Type a Long Description. (optional) 

5. Place a check mark in the box if item or service is taxable.

6. Click Add. New Custom Charge is now added to the Custom Charges List. 

Inactivate a Custom Charge

1. To inactivate a Custom Code and delete it from the Code List, Place a check mark in the Inactive
box. 
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2. Click Save.

Note: This will not completely remove it from the data base, but will hide it from view if there is also a
check mark in
the Hide Inactive Codes option.

Custom Charge Search by Code

Begin typing the Custom Charge code in the Code Search and as you type, the codes and short
descriptions are
listed.

Custom Charge Search by Description

Begin typing the Custom Charge description in the Short Description Search and as you type, the
codes and short
descriptions are listed.

Custom Charge Effective, Modified and Deactivation Date

1. Effective date column lists the year the code is in effect.

2. Modified Date column lists the date the code was last modified.

3. When a Custom Charge code is discontinued Deactivation Date column will list the date it was
discontinued.

Note: The dates are automatically inserted when the code is modified or updated.

Hide/Show inactive Custom Charges

If a code had been Inactivated and is no longer going to be used it can be removed from the Code List
by placing a check mark in the Hide Inactive Codes box.
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11. Fee Schedule Maintenance (Block 24F)

Tools menu -> Billing Maintenance -> Fee Schedule Maintenance

Fee Schedule Maintenance

This screen shot shows the Maintenance screen after building 4 different Fee Schedules. The Default
Fee Schedule amounts will have to be manually entered, and other Fee Schedules can be based on
those fees. Aetna and BCBS AR are based on 100% of the existing Default fee schedule. Medicare is
Based on 99% of the Default Fee Schedule for this example.
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Adding Codes to a Fee Schedule

Begin by adding Procedure and HCPCS codes to the Default Fee schedule. 

1. Click on the Drop Down Arrow in the Name field to open the Name(s) of existing fee schedules.
2. Double Click on Default in the Drop Down list.

3. Click the Add Code button to open the Code Search dialog.
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4. Begin typing the code and as you type, a list of codes and the Description of the codes will display.
5. When the correct CPT/HCPCS is in the Code and Description search field, Click the Okay button.

6. Click the Add Code button and repeat steps 4-5 until Code list is complete with Procedure codes and
HCPCS codes most commonly used in your practice
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Create a Fee Schedule by Manual Entry

Use the newly created list of codes to add a charge for each code in the Default Fee Schedule. Make
sure the Manual Entry option is selected

1. With Default Fee Schedule still selected, Click the Update Codes button in the Fee Schedule Details
to open the Default Codes Update dialog.
2. Begin typing the code.
3. Type a charge amount for the code. The Default Amount field will automatically populate when
applied.
4. Click the Apply button. 
5. Repeat steps 2-4 until all codes have a fee applied and Click the Close button.

Note: Codes will have to be added to the Code List before they can be found in the Codes Update
dialog list.  
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Create a Fee Schedule Based on an Existing Schedule

A Fee Schedule can be automatically priced based on a percentage of any of the existing fee
schedules.
1. Add a new fee schedule and Type a name for the schedule.
2. Click Based On Existing.
3. Select Default from the Drop down list and Type a percentage of the Default fee schedule amount to
base the new fee schedule charge.
4. Click the Add button. 

5. Scroll over to the column to verify the new Fee Schedule has been added to the Code List.
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Update fees for codes added using the Manual Entry Option

Update all Fee Schedules that have been added using the Manual Entry option. If a Fee Schedule has
been added using the Based on Existing option, those steps will follow.

1. With Default Fee Schedule selected, Click the Update Codes button in the Fee Schedule Details to
open the Default Codes Update dialog.
2. Begin typing the code.
3. Type the updated fee for the code. The Default Amount field will automatically update when Applied
and Closed.
4. Click the Apply button. 
5. Repeat steps 2-4 until all codes have been updated, and then Click the Close button.
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Update codes with fees Based on Existing Fee Schedules

Prior to updating fees that have been added using Based on Existing Fee Schedule option, the Based
On Fee Schedule will have to be updated by following steps in the Update fees for codes added
using the Manual Entry Option section of this manual.
1. Scroll to find the fee schedule to update and then Click anywhere inside the column. In this example
Cigna is the fee schedule selected.
2. With the Fee Schedule in the Name field of the Details section, Click on the Preview button. The fees
will change according to the percentage amount.
3. Click on Save.

Practice Management 2010.3 User Manual - 77



Searching for a fee by code  

Search all Fee Schedules for fees applied to codes by code number.
1. Click inside the Code Search field in the Code list section and begin typing the Code. The code is
highlighted for each fee schedule displaying the fee.

Hide Inactive Fee Schedule(s)

If a Fee Schedule has been Inactivated and is no longer going to be used it can be removed from the
Fee Schedule List
by placing a check mark in the Hide Inactive Items box.
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Inactivating a Fee Schedule

1. To inactivate a Fee Schedule and delete it from the Fee Schedule List, Place a check mark in the
Inactive box.
2. Click Save.
Note: This will not completely remove it from the data base, but will hide it from view if there is also a
check mark in the Hide Inactive Codes option.
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12. Insurance Company Manager

Tools -> Insurance Companies

Insurance Company Maintenance

 
Add new Insurance Companies, Edit existing Insurance Companies and Associate Providers to
Insurance Companies when submitting Insurance Claims. 

1. Add a new Insurance Company. 
2. Edit an existing Insurance Company.
3. Delete an Insurance Company.
4. Click inside the blank grid directly below column headers and begin typing to search by name, City,
State, etc.
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Add a New Insurance Company

1. Click Add New Company icon to open Edit Insurance Company dialog.
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2. Add Insurance Company information including:
Type-This will be used to determine which box to check in Block 1. on the CMS 1500 form.
Group Provider (Legacy)- If the Insurance Company requires a Legacy number in addition to a NPI
number, Type the Group/Pay To number here.
Fee Schedule (Legacy)- This is for information purposes only, any Legacy Fee Schedules previously
assigned to this Payer.
Fee Schedule- Use the Drop Down option to select a Fee Schedule from the list in Fee Schedule
Maintenance, or leave blank and it will use the Default fee schedule
3. Check the box if applicable:
Active This box will default to active. Click to remove check mark if the Company becomes inactive/no
longer a valid Insurance Company.
Show Legacy ID If checked, the Legacy numbers entered in the Company information will be included
on all claims.
Default Electronic Check box if claims for this insurance company will go to the payer electronically. If
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not checked, claims will be printed on a CMS 1500 form. 

Note: If a Payer/Insurance Company normally accepts only paper claims, but claims will be sent to
GatewayEDI to drop to paper and forward to the Payer, see next step for setup information.

Electronic Insurance Submission Setup

4. Electronic Submission Info is inserted into the Electronic Insurance files to identify Payer ,
Clearinghouse and Type of claim.

Note:  All fields are required when submitting electronic claims. Payer ID and Receiver ID.will be
provided by your Clearinghouse.

Payer Qualifier-Identifies type of Payer ID. (For most Payers, this will be ZZ-Mutually Defined)
Payer ID-Identifies the Payer of claims submitted for this Insurance Company. (GatewayEDI will
provide a list of your Payer IDs)

Note: All payers that will be sent electronically to GatewayEDI and then dropped to paper claim by
Gateway, will be Payer ID 00010

Clearinghouse Name-Identifies the Clearinghouse. (GatewayEDI)
Clearinghouse ID-Identifies the Clearinghouse. (GatewayEDI  ID shown in example)
Type (If Primary) - Identifies the Type of claim/insurance company. For Primary, the most common
types will be:
CI - commercial
BL - BCBS
MC - Medicaid
MB - Medicare 
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Type (If Secondary)-Identifies the Type of claim/insurance company. For Secondary, the most
common types will be: 
SP-Supplemental Policy
GP - Group Policy
MI - Medigap Part B

Receiver Qualifier-Identies the Receiver ID.  (For most Receivers, this will be ZZ-Mutually Defined)
Receiver ID-Identifies the Receiver of the Electronic file submitted. (GatewayEDI Receiver ID shown
in example)

The information in Provider Setup section is required when filing claims, and is used to file to identify
the Rendering Provider of Service, The Pay To Group/Provider and other identifiers.

5. Click the New Provider Mapping button (Green +) to add Providers of Service to this Insurance
Company. 
6.  Click to highlight a Provider and Click the Add button to open the Edit Billing Information dialog.
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Edit Billing/Pay To Information for Payer-Add Taxonomy Code/Legacy IDs 

Edit Billing Information dialog is used to identify Billing/Pay To information (top portion) and Rendering
Provider of service (bottom portion). This information will be included on all claims submitted to this
Insurance Company.  

7. This section is populated with data used when setting up Manage Groups. Verify that this is the
correct Pay To information. To edit information and Add a Submitter Id for Electronic claims, Click to
place a check mark in the Override Group Values box.
8. If the Pay To provider is an individual and payments are reported to his Social Security number, Click
SSN and type social security (Block 25)
9. Use drop down to select type of ID number to include in the file-Billing Legacy number, Billing
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Taxonomy code, etc. and enter the number in the next field. T 
10. For Electronic claims, use the drop down arrow to select an identifier for the Submitter ID and then
Type the ID into the ID field. This information is provided by your Clearinghouse or Receiver of
electronic files. For paper claims, leave blank.
10. This section is populated with data used when setting up Provider Manager . If this insurance
requires a Rendering Provider Legacy number  or a Rendering ProviderTaxonomy Code for the
Rendering Provider, in addition to the NPI, use the drop down arrow to select an identifier for the ID and
then type the ID into the field. (Block 24j)
11. Click the Save button. Save Mapping dialog asks if you would like to link this insurance company to
the specified group, Click Yes.

Delete Insurance Company          Tools -> Insurance Companies

Tools -> Insurance Companies

1. Click on the Insurance Company to be deleted.  

2. Click on the Remove Company Icon (Red X). You will be prompted to verify that you want to
remove the selected insurance company. 
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3.  You will be prompted to verify that you want to remove the selected insurance company. Yes to
delete, No to cancel 

Note: Users must have security privileges to delete an Insurance company. Insurance demographics
will have to be updated for any patients that  have the deleted insurance company in their information.
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13. Contacts/Referring Physicians (Block 17)

Tools -> Contacts

Additional information in SOAPedia

Add a new Contact/Referring Physician

1. Click Add New Contact button to create a new contact. 

Note: To edit an existing Contact, double click on contact name to open Edit Contact Information dialog.
To delete a contact, click on the X next to contact name.
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1. Contact Information: Complete the Contact's basic demographic information. 

2. Provider Information: Enter the referring physician's NPI, Specialty and Taxonomy code. 
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3. Insurance Information: If any legacy IDs are needed for referrals when filing with certain insurance
companies, you can enter these IDs under Insurance Information. See below steps for adding a legacy
ID. 

Insurance Information

3. Click the New Insurance Mapping button in the Insurance Information section to open the Select
Insurance Company dialog.

4. Click the Drop Down button to display a list of available Insurance companies.

Note: Most insurance companies require only the NPI number of the Referring Provider. If the selected
insurance company requires a legacy number or Taxonomy Code, proceed to step 5. If not, the Contact
setup is complete for this Referring Provider.
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Add Legacy IDs/Taxonomy Codes

To access the list of Taxonomy Codes, Click on the link http://www.wpc-edi.com/content/view/793/1

5. Click the Drop-down button to display the list of different types of legacy numbers, including
Taxonomy Codes followed by the legacy number ID Qualifier.

6. Type the Legacy number and then Click Save. 
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14. Custom Demographic Titles

Tools -> Custom Demographic Titles

The Custom Demographics section of the chart contains the information not otherwise contained
elsewhere in the demographics area, but which may be needed in most patients' charts. Setting the
custom demographics titles has changed slightly from SOAPware 4.x. Custom field 13 is a note or
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memo text box; it is used to store more information than the other fields.

By editing custom demographics titles, you can add additional demographic fields to SOAPware, with
names that you assign them. To modify the custom demographics headings:
1. Click Tools-Custom Demographic Titles
2. You will see a list of custom demographics text boxes. The current name of each field is shown in an
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edit box where you can enter the new name.
3. Fill in as many of these fields as you wish, then click Save to save your changes.
4. Click Save, then close SOAPware and restart to see the new titles displayed.
Note: This setting will change the titles of all custom demographic fields on all patients in the database.
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15. Set Structured CPT Options

Tools -> Options -> Structured CPT
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Select Structured CPT Sub items

1. Select Sub items for the Structured CPT items when inserted in the Plan Section of the SOAP note
for documenting Encounters/Visits.

2. To exclude a sub item, click the box to remove the check mark. 
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3. Screenshot of Structured SMARText item within the SOAP note using the select options above. 
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Updating CPT, HCPCS, and
ICD-9 codes 
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1. Download new quarterly/annual codes

Steps to download the latest database of CPT, HCPCS or ICD codes - When the below steps are
followed and completed, any new or revised codes will be downloaded on your local database, and any
newly inactivated codes for the coming year will no longer be available on SMARText Online database. 

Clinical Suite Only: New codes will be automatically added to the Billing Maintenance databases, and
revised codes, when downloaded on the SMARText Online library, will be updated in the Billing
Maintenance databases. Deleted codes will have to be inactivated manually.
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Download new codes in the SMARText Items dialog

1. Click on the SOAPware menu and select Chart.
2. When in the Chart domain, go to the Docutainers menu and select SMARText Items (or hit F10 on
your keyboard). 
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Find the new code set on the SMARText Online Library

1. Make sure that you have the Include Online Library Items box checked. 
2. Enter the code needing to be downloaded into the Find box to access the new codes. NOTE: If
there is a group of codes that start with the same few numbers or letters, you can enter those into the
find box, and it will pull up all of the codes with that beginning set of numbers/letters. (For example, if
you were wanting to pull up the grouping of office visit codes, you could enter 992 into the find box, and
it will find all the office visits with those numbers. You can also type in a general description word, such
as knee, xray, etc to search for groupings of codes.)

3. Click the Search button to search the entire online library for the new codes. 
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Download a new code set

1. Once the list appears, click on the first line shown.
2. Press down the Shift key on your keyboard. 
3. Using your mouse scroll all the way to the bottom of the list and click on the last item shown (while
still having the Shift key held down). 
4. You should see every line item selected in blue. 
5. Let up on the Shift key and click the downward facing Blue Arrow to update, as indicated in the
image above.
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PM Code database updated (Clinical Suite Only)

As soon as items are downloaded locally from the SMARText online library, the codes are brought over
and made available in the Billing Maintenance Code databases. The updated and/or new codes will
show a modified date as the date that the codes were downloaded and brought over. 
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New Code Procedure

New codes will automatically be placed in the PM databases (CPT, HCPCS, ICDs) when they are
downloaded from the SMARText Online Library as shown in the lesson Download new quarterly/annual
codes

Download new CPT codes

Download SMARText items from the SOAPware Library by typing the appropriate keyword(s) and
updating all codes as shown in previous lesson Download new quarterly/annual codes.
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Revised Code Procedure

Update Revised CPT, HCPCS and ICD-9 codes. When the steps are followed and completed in the
lesson Download new quarterly/annual codes, the revised codes will be updated automatically in the
PM Code Database. NOTE: Any custom descriptions that were entered prior to the download of the
new codes will remain intact during the update. Revised codes can be identified in SMARText Items by
the keyword **NeedsUpdated-2011**

Update Revised Codes

Follow the steps as shown in Download new quarterly/annual codes to automatically update the revised
codes.
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Deleted Code Procedure

When a CPT, HCPCS or ICD-9 code is deleted or no longer a valid code, it will be removed from the
SMARText database but will have to be inactivated in Tools ->Billing Maintenance-> CPT Maintenance
, HCPCS Maintenance and ICD Maintenance for the PM Code Databases.

Inactivate a code

1. To inactivate a CPT Code, place a check mark in the Inactive box. 
2. Click Save and repeat for each code on your list. 

This will not completely remove it from the database, but will archive it and hide it from view.
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Schedule Setup
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Activate Providers/Resources for a Facility

Steps on how to set scheduling defaults.

To access the Scheduler, go to the SOAPware menu and click Schedule.

Add a Facility

1. Click on the Tools menu.
2. Select Manage Facilities.
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Create a New Facility

Click the Create New Facility button, to setup a new facility. If you already have a facility setup, skip this
lesson.
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Scheduler

Click the Scheduler tab to setup the clinic's defaults.
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Opening the Provider's Schedule Defaults

1. Click on a provider name. 
2. Click Edit.
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Making a Provider visible for the Clinic

1. Check the box next to Visible to activate the provider for the clinic.
2. Click OK.
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Set Working Hours for the Provider

1. Click on a day.
2. Click Edit.
3. Enter the Start and End Times.
4. Check to make the Provider Available for that day, in the select clinic, if needed.
5. Click OK.
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Provider/Resource Outlining

Setup outlining blocks for Providers and Resources to streamline their time in the office. 

Open the Facility Manager

1. Click on the Tools menu. 
2. Select Manage Facilities.
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Edit a Facility

1. Select a Facility.
2. Click the Edit Facility button.
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Select the Scheduler Tab

Click on the Scheduler Tab.
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Select a Provider or Resource to Edit

1. Click to select a Physician. 
2. Click the Edit Provider Information button.

Note: This is the same process for Resources. To Edit a Resource, just click the tab Resources and
follow the above steps.
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Open Outlining

Click on the Outlining tab.
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Create an Outline

Click the Add Outline

Set the Outline 

Outline Name: Name the type of appointments that should be scheduled in the designated time slot.
(This name will show up to the left of the Schedule with the associated color, for schedulers to have a
reference for the shading.)
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Outline Color: Click the drop down and select a desired color to associate with the outline and be
shown on the Schedule. 

Open Time: Set the time period for the outline. 

Days: Check all days that this outline and selected time will be in effect. 

Note: When scheduling, these outline blocks will not prevent any other appointments from being
scheduled during the block. They are merely referential for front office staff to aid as a guide when
scheduling. You can override, if needed.

Click OK when done. Repeat this for each outline for each Provider/Resource needed.

Activate and view the Outline shading

1. Click on the Scheduler menu. 
2. Click on Coloring. 
3. Select Resources. 
4. Click By Outlines.
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You should then see the coloring change on the Schedule and see the outline blocks you set up.
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Provider/Resource Recurrences

Setup recurring appointments for Providers and Resources to block out their schedule in the intervals
selected and not allow any other appointments to be scheduled.

Open the Facility Manager

1. Click on the Tools menu. 
2. Select Manage Facilities.
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Edit a Facility

1. Select a Facility.
2. Click the Edit Facility button.
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Select the Scheduler Tab

Click on the Scheduler Tab.
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Select a Provider or Resource to Edit

1. Click to select a Physician. 
2. Click the Edit Provider Information button.

Note: This is the same process for Resources. To Edit a Resource, just click the tab Resources and
follow the above steps.
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Open Recurrence Tab

Click on the Recurrence tab.
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Create a Recurrence

Click the Add Recurrence.
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Setup the Recurrence.

Appointment Time: Set the Start Time and End Time for the specific recurrence.

Recurrence Pattern: You can set the intervals for the recurrence in this area. Below are the option:
  Daily: Setup the number of day intervals between occurrences or select to have the appointment set
for every weekday (Monday - Friday).
  Weekly: Setup the number of week intervals between occurrences and check the specific days of the
week for the appointment to occur.
  Monthly: Create the appointment on a particular day in month intervals (for example, every 5th day of
every 3rd month, with the numbers being able to be customized by you). You can also indicate a
particular day of every month for the appointment to occur.
  Yearly: Indicate every Month and Day for the year year or indicate the (first, second, third, fourth or
last)  (day, weekday, weekend day, Sunday, Monday, Tuesday, Wednesday, Thursday, Friday or
Saturday) of a select Month.

Range of Recurrences: Set recurrence to start by a certain date and end either after a set number of
occurrences or by a set end date.  
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Comments:  Name the recurrence in this field. The text entered here will be what is shown on the
Recurrence from the Schedule. 
 
Click Save. Repeat this for each recurrence needed for each Provider/Resource needed.
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Entering Facility Business Hours

Set up the hours of operation for a facility.

Tools > Manage Facilities 

Open the Facility

1. Select the Facility. 
2. Click Edit. 
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Scheduler

Click the Scheduler Tab.
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Edit Business Hours

1. Click on a day of the week.
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Edit the day

1.  Enter the Open Time of the clinic for the specific day.
2.  Enter the Close Time of the clinic for the specific day. 
3.  Check the box next to Is Open if the facility will be open for business on the specified day of the
week. 
4.  Click OK to save.
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Update the Schedule

Click the Update button to update the Schedule.
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Creating Holidays/Closings

Set up the days the facility will be closed.

Tools -> Manage Facilities 

Open the facility.

1. Select the Facility. 
2. Click Edit. 
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Click Scheduler.

Click the Scheduler Tab.
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Create Facility Closings.

1. Click the Add Closing button. 
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Edit the day.

1.  Enter the Name of the closing.
2.  Enter the Start and End Dates of the closing.
3.  Click OK to save.
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Update the Schedule.

Click the Update button to update the Schedule.
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Creating Scheduplates

Set up facility appointment types.

Tools -> Scheduplates

Open the Scheduplate Manager.

1. Click on the Scheduler menu.
2. Select Manage Scheduplates.
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Add a Scheduplate.

Click the Create New Template button. 
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Enter Scheduplate information.

1. Type in a Scheduplate Name and Abbreviation. The abbreviation will be shown on the
appointment at a glance, and the full scheduplate name will be helpful in selecting the correct
appointment type. 
2. Select a Background color to show on the appointment.
3. Select a Foreground color for the text displayed. (After selecting the background and foreground
colors, the sample text will display what the appointment will look like on the Schedule.)
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Adding a Resource.

Click the Add Resource button.

Entering Resource time.

1. Select the Resource to whom the scheduplate will apply. 
2. Enter the number of minutes needed, prior to the patient being seen by the Provider/Resource.
3. Enter the Duration of the appointment with the resource selected. This indicates the length of time
needed with the Resource.
4. The Start Cushion indicates the amount of time needed to prepare the patient for the
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Provider/Resource's time. Enter the number of minutes by typing the number or clicking the arrows.*
5. The End Cushion allows for any follow up work related to the appointment to be indicated and
accounted. Enter the number of minutes by typing the number or clicking the arrows.*
6. Click Save.

*Both the Start and the End Cushion are designed to help prepare for the full length of the appointment.
These fields are not necessary to create a scheduplate.

Update Scheduplates.

Click Update to save the scheduplate.
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Menus and Toolbars
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SOAPware Menu

Provide orientation and descriptions of the SOAPware menus.

SOAPware Menu

Displays the various workspaces in SOAPware.
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Billing Menu

Provide a description and orientation of the Billing menu. 

Billing Menu

Provides access to the most commonly used billing related activities.
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Scheduler Menu

Provide a description an orientation of the Scheduler menu.

Scheduler Menu

Provides all of the Scheduling options and functionality needed for everyday use of the Schedule.
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Edit Menu

Provide a description of the Edit menu.

Edit Menu

Provides common editing tools. 
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Tools Menu

Provide a description and orientation of the Tools menu.

Tools Menu

Displays all of the master dialogs for setting up and customizing the SOAPware EMR and PMS.
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View Menu

Provide a description of the View menu.

View Menu

Provides various navigation tools to help with more quickly moving between workspaces.
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Help Menu

Provide a description and orientation of the Help menu.

Help Menu

Provides links to all of the available SOAPware resources to help with training and support of
SOAPware.
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Patient Account Overview
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Looking Up a Patient Account

Learn how to search for an existing patient from the Chart Rack.

Pull up the Chart Rack

1. Click on the Billing menu. 
2. Select Patient Account. 

OR 

Hit Ctl + A on the keyboard.
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Search for a Patient

1. Select the type of information to search. The options are Birth Date, Chart #, Name, Phone # and
Social Security #. The default option will be Name if nothing is selected. 
2. Type in a name or number to search. If looking for a patient name, the system will search by last
name. 
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Select the Patient.

When the patient needed has been pulled up, click on the name and hit Select; or hit Enter on the
keyboard.
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Creating a New Patient

How to create a new Patient Account. 

Pull up the Chart Rack

1. Click on the Billing menu. 
2. Select Patient Account. 

OR 

Hit Ctl + A on the keyboard.
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Create a New Patient

1. ALWAYS search the existing patient database for a patient BEFORE creating a new chart. This
helps prevent duplicate charts from being created.
2. Click the Create Chart button.  

Enter First and Last Name.

1. Type in First and Last Name.
2. Click OK.
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Enter Demographics

Enter demographic information as provided. 
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Patient Information Bar

Show the highlights of the Patient Account Information bar.

Patient Information At-A-Glance

Allows demographic and balance information to be easily seen without having to search.  
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Schedule Tab

An overview of the patent's appointment details and history displayed on the Schedule tab.

Schedule Tab - Patient Appointments

1. Visit Detail: Summary of the overall length of the appointment
2. Scheduplate: The appointment type 
3. Referral: Referring Provider
4. Facility:  Place of Service
5. Status: The status of the patient visit within the clinic's work flow. (This list is completely
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customizable by clinic.)
6. Recurrence: Sets recurrences of the visit, if needed. 
7. Resources: Allows the scheduling of one to multiple resources for one visit
8. Visit Comments: Allows miscellaneous information and visit details to be entered and stored for the
visit.
9. Verification: Indicates the date and user who verified the patient's insurance benefits and eligibility. 
10. Check-In: Allows a patient to be checked in with the click of a button. 
11. Take Co-Pay: Allows a patient's co-pay to be taken at the beginning of the visit.
12. Visit List: Displays all of the patient's past, current and future appointments to be displayed in one
place, to help prevent double booking an appointment. 
13. Today: Immediately selects the current day's visit. 
14. Print Visit: Prints out the selected visit.
15. New Visit: Creates a new appointment for the patient.
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Confirming Patient Appointments

By clicking the left and right arrows for a Resource, you can move to the previous or next
appointment for that resource to confirm appointments, without ever having to go out and back in of
each appointment on the Schedule.

When you want to mark a patient as Confirmed, you can select that status from the Status dropdown as
shown above and make a note in the visit columns, if you like.
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Demographics Tab 

Patient Demographic Information

Patient Demographics

1. Patient Name: Title, First Name, Middle Initial, Last Name, Suffix
2. SSN: Social Security Number
3. Birth Date: Date of Birth is entered manually, and Age is automatically calculated.
4. Marital Status
5. Gender: Patient sex
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6. Race: Important for meaningful use guidelines
7. Ethnicity: Important for meaningful use guidelines
8. Language: Important for meaningful use guidelines
9. Patient Address
10. Contact Information: Phone and Email
11. Primary Provider: Provider within the Clinic that is treating the patient
12. Referring Provider: External provider who referred the patient to the clinic
13. Primary Care Physician
14. Preferred Pharmacy: Default pharmacy for sending the patient's prescriptions
15. Guarantor: Person/Entity that is financially responsible for the patient's account and balance.
16. Financial Class: Indication of the patient's financial position.
17. Student Status: Indicates whether the student is an active student
18. Add Scan: Allows documents and forms to be scanned in as part of the patient's demographic
profile. (The scanned document goes next to the General tab as a reference document.)
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Insurance Demographics Tab

Display of the patient's insurance policies

Patient Insurance Policies

1. Primary Insurance Policy 
2. Secondary Insurance Policy
3. View: Displays details of the patient's insurance policy
4. Scanned Insurance Card(s): Display as tabs on the Insurance tab for reference.
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Adding a New Insurance Policy

Click the Add New Policy button. 
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Required Fields if Relation to Insured is Self

Relation to insured will default to Self with most information automatically populated with data from
patient demographics, and only the Company and Policy # will be required. 
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Note: Data cannot be saved until all required fields are completed.

Relation to Insured is other than Self

If Relation to insured is changed, all data from patient demographics is cleared and users are alerted to
required fields as shown in this screenshot.

Note: Data cannot be saved until all required fields are completed.
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Entering Insurance Policy Details

1. Type of Insurance Policy
2.  Insurance Company 
3.  Insured Information
4.  Policy Details
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Custom Demographics Tab

Custom Demographics

Customizable Demographics

Allows unique patient information to be tracked and entered based on the clinic's preferences.
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Ledger Tab

A summary of the patient's financial activity.

Ledger Tab - Financial Summary

Double click on any line item to drill down and get more details.
1. Add Adjustment: Add an adjustment for the individual patient account, as needed.
2. Add Charge: Add a non-billable charge to the patient. Charges entered from the ledger will not be
billed to insurance. (All charges to be submitted to Insurance must be processed in New Charges.)
3. Add Payment: Add a Payment on the patient's account and apply across all charges. 
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4. Print Receipt:  Print a patient receipt on demand 

Charge Details

Double click any charge line item from the ledger to view the above details: 
1. Dates of Service
2. Rendering Provider
3. Units of the Charge
4. Fee for the Charge
5. Associated Diagnosis codes
6. Associated Modifiers
7. Miscellaneous notes applying to the charge
8. Payments or Adjustments that have been applied towards the charge.
9. Totals for the Charges, Personal or Insurance Payments, Adjustments and Related Balance
10. Miscellaneous details pertaining to the charge
11. Insurance Payments that have been applied to the charge.
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Personal Payment Details

Double click any personal payment line item from the ledger to view the above details: 
1. Payer: The person making the payment
2. Payment Details: Payment method and amount
3. Comments: Any miscellaneous information pertaining to the payment
4. Applied: Shows how the payment was applied across charges
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Adjustment Details

Double click any adjustment line item from the ledger to view the above details: 
1. Date: Date the adjustment was entered
2. Adjustment code
3. Adjustment Description
4. Amount: Total adjustment amount applied to the patient's charges
5. Applied: The line item view of how the adjustment was applied to each charge.
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Family Tab

View a patient's family balance and pending claims.

Family Balance

1. Guarantor: View the patient's guarantor
2. Add Dependents: Add dependents under the active patient to be included in the patient's family
balance.
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Claims Tab

View all of the patient's claims and any related claim details. 

 Patient Claims View

1. Claims: A listing of all of the patient claims, both pending and submitted. 
2. Claim Details: The claim details listed in this section represent the claim that is selected in the
Claims list above.
3. Double click the line item to further view the specific charge details.  
4. View additional claim info.
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Statements Tab

View any patient statements that have been sent out and reproduce with the click of a button.

Statements Tab

1. Double click on any statement listed to see the original statement sent.
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New Charges Tab

Transaction entry for patient charges, payments and adjustments

New Charges Tab

1. Add Charges for the patient account quickly. 
2. Add Payment across charges for the active patient and dependents or other patients, if needed, all
from one screen.
3. Edit Charge Details by double clicking the line item.
4. Specify the Follow-up Action for the charges posted.
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5. Any provider Follow-up Comments or instructions entered by the provider on the billing statement
will show up here.
6. Enter any Claim Comments to the billing staff when processing claims. 
7. Add an Adjustment at the time of posting.
8. Post charges, payments and adjustments to the patient's ledger. If Submit to Insurance is
selected and there is an active insurance policy for the patient, a claim will be automatically generated. 
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Scheduling
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Changing Active Facility

Changing the active facility, if a multiple site practice. 

Scheduler menu -> Active Facility

Open Active Facility

1. Click on the Scheduler menu.
2. Select Active Facility.

Select the new Active Facility

1. Click the drop down menu to find the correct facility.
2. Click Select.
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Navigation

Show the various ways to move around in the Schedule.

Move Quickly between Days, Weeks, Months

1. Move back 1 day.
2. Move back 1 week.
3. Move back 1 month.
4. Move ahead 1 day.
5. Move ahead 1 week.
6. Move ahead 1 month. 
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Monthly Calendar

Click the arrows to move quickly to the date needed.
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Views

View the Schedule as Days, Weeks, Months, or Work Weeks. 

Scheduler menu -> View 

Select the appropriate Schedule View.

Select the view that allows the easiest and clearest view of the Schedule. 
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Time Increments

Set the time increments shown on the Schedule.

Scheduler menu -> Time

Select the Time Increment

Choose the option that best fits your practice's scheduling needs. The time increment selected here will
be displayed to the left of your schedule.
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Coloring

Set the coloring for Appointments and Resources. 

Coloring for Appointments

1. Click on the Scheduler menu. 
2. Select Coloring. 
3. Select Appointments. 
4. Select either By Status or By Scheduplate. By Status will show the shading of the status as it
changes, and not show the Scheduplate coloring. By Scheduplate will the shading associated with the
Scheduplate and not show the status color changes. 
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Coloring for Resources

1. Click on the Scheduler menu. 
2. Select Coloring. 
3. Select Resources. 
4. Select either By Working Hours or By Outlines. By Working Hours will only show the hours the
Provider is available to see patients in the clinic. By Outlines will show the outline shading associated
with how the providers have indicated they want their days scheduled.
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Export the Schedule

Export the clinic schedule.

Export the Schedule.

1. Select the Scheduler menu.
2. Click on Exports.
3. Select Export Schedule. 
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Select the Facilities/Resources to Export 

1. Check the boxes of the Facilities to be shown.
2. Select the Resources whose schedules need to be exported. 
3. Enter the range of dates to be exported. 
4. Check to include the Visit Comments on the report as reference, if needed. 
5. Click Select.  The file will be exported as a CSV file.
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Schedule Reports

Access reports on the Schedule data.

Scheduler -> Reports

Print various Schedule Reports

1. Go to the Scheduler menu. 
2. Click on Reports. 
3. Status Report: View a summary of patients based on their appointment status.
4. Patient Report: Provides both a summary of the specified patient's appointments, but also provides
a breakdown of the time spent at each status of each appointment.
5. Print Simple Schedule: Provides a summary of the appointments scheduled by Provider. Indicates
the Time, Patient Name, Phone Number, Scheduplate, Status and visit Comments.
6. Print Advanced Schedule: Provides a summary of appointments scheduled across Facilities and
Resources. Time, Patient Name, Phone Number, Scheduplate, Status and visit Comments.
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Searching for Available Appointments

Find Open Appointments

Scheduler menu -> Find Open Appointment

Find Open Appointment

1. Click on the Scheduler menu. 
2. Select Find Open Appointments. 
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Enter Basic Search Criteria

1. Select the Resource needed from the drop down menu.
2. Enter the date ranges for the possible appointment.
3. Enter the Start and End Cushions that the appointment will need to have.
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4. Enter the Duration for the appointment needed. 
5. Click Search. 
6. If a suitable appointment has been found, select the appointment time.
7. Click Select.

Enter Advanced Search Criteria 

1. Check the Facility needed for the appointment.
2. Enter the date ranges for the possible appointment.
3. Select a preferred Scheduplate that the appointment will need to have.
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4. Add a Provider/Resource to search.
5. Click Search. 
6. If a suitable appointment has been found, select the appointment time.
7. Click Select.
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Scheduling an Appointment

Schedule a Patient Appointment

Double Click on a Needed Time Slot

1. The Chart Rack will be pulled up. 
2. Type in the Patient Name. 
3. When the correct patient is pulled up, click Select or double click the patient.
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Schedule Tab - Patient Appointments

Enter the below Appointment information, as needed:

1. Visit Detail: Summary of the overall length of the appointment
2. Scheduplate: The appointment type 
3. Referral: Referring Provider
4. Facility:  Place of Service
5. Status: The status of the patient visit within the clinic's work flow. (This list is completely
customizable by clinic.)
6. Recurrence: Sets recurrences of the visit, if needed. 
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7. Resources: Allows the scheduling of one to multiple resources for one visit
8. Visit Comments: Allows miscellaneous information and visit details to be entered and stored for the
visit.
9. Verification: Indicates the date and user who verified the patient's insurance benefits and eligibility. 
10. Check-In: Allows a patient to be checked in with the click of a button. 
11. Take Co-Pay: Allows a patient's co-pay to be taken at the beginning of the visit.
12. Visit List: Displays all of the patient's past, current and future appointments to be displayed in one
place, to help prevent double booking an appointment. 
13. Today: Immediately selects the current day's visit. 
14. Print Visit: Prints out the selected visit.
15. New Visit: Creates a new appointment for the patient.
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Moving an Appointment

Moving an Appointment  to a different time slot

Dragging and Dropping

1. Click to select the appointment.
2. With the left mouse button held down, drag the appointment to the desired time slot. The
appointment should then be placed at a new time, and the patient's appointment details updated
automatically. 
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Cutting and Pasting

1. Click to select the appointment. 
2. Right click on the mouse and select Cut.
3. Click the desired time slot. Right click on the mouse and select Paste. The appointment should
then be placed at a new time, and the patient's appointment details updated automatically. 
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Deleting an Appointment

Delete a patient appointment

Delete an Appointment

1. Click to select the appointment.
2. Right click the mouse and select Delete, or hit Delete on the keyboard. (A warning will pop up to
make sure the appointment is to be deleted. Click Yes to continue or No to cancel.)

Practice Management 2010.3 User Manual - 201



Changing Appointment Status

Changing an Appointment Status

Right Click to Change Appointment Status

1. Click to select the appointment. 
2. Select the needed status for the appointment. (The status should be updated automatically on the
Schedule and in the patient account.)
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Scheduling Repeat Appointments

Setting up repeat appointments.

Open the Patient Account

1. Double Click the appointment, needing to be repeated.
2. The Schedule Tab will open. 
3. Click Recurrence.

Practice Management 2010.3 User Manual - 203



Recurrence Management

Click the Create Recurrence button.

Practice Management 2010.3 User Manual - 204



Set the Recurrence Pattern

1. Enter the appointment time.
2. Select whether the appointment will be on a Daily, Weekly, Monthly or Yearly basis. 
3. Indicate how long the recurrence will take place. Select the Start Date, as well as either the number
of occurrences for the appointment or an End Date for the recurrence.
4. Click Save. The recurring appointments should be scheduled, and the patient account updated
automatically. 
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Transaction Entry 
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Post a Superbill/Billing Statement from Patient Chart

Post a Superbill/Billing Statement from Chart

1. An encounter/visit should already be documented in the SOAP note section of the Patient Chart.
Structured SMARText items must be used in the Plan and Assessment fields as shown in the
screenshot.
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2. Click to view Billing Statement.

3. Click the Post Superbill icon.

4. Dialog will display with message The superbill was successfully posted. Click the OK button

5. Go to the main menu and Click Billing 
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Open Patient Account in Billing

6. From the Billing menu Click Patient Account to open the Chart Rack

7. Search Chart Rack for Patient Account. This example shows search by Name. Begin Typing patient
last name until the patient is visible in the list of patients
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8. Click to highlight Patient from the Chart Rack list and then Click Select. Patient account will open

View Posted charges in New Charges Tab

Patient account will open to the New Charges Tab when a Superbill has been posted to Billing. The
upper section displays Patient demographic details and Personal/Family account balances.

The Center section lists Visit details as documented in the SOAP note section of the patient chart.
Charges are added for the Procedure Codes and can be edited by Double Clicking on the line of the
charge as described in the Edit/Update Charges lesson. Payments, Adjustments and Additional 
Charges can be added manually, as needed.
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The bottom section allows the user to:
1. Set follow up action for the claim. If insurance information is entered in the Patient Demographics,
this will default to Submit to Insurance. 
2. Check as Incomplete, allowing the user to close out of the account and come back later to finish the
check out process. 
3. Print a Receipt when the visit is posted to the ledger.
4. Displays Doctor Comments typed in Billing Statement Tab.
5. Type free text Comments pertaining to the claim (informational only) 
6. Add personal Payment to account
7. Post transactions to Patients Ledger
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Transfer Credit Balance 

Transfer a credit on one visit and apply to another visit. 

Note: Adjustment codes will have to be set up in Adjustment Maintenance before this can be done.

Adjust Credit

1. Open the Ledger tab. 
2. Select the visit with a credit and click to highlight.
3. Click on the Add Adjustment button.
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4. Type adjustment code .
5. Click the arrow on the line with the credit and type '-' and then the amount to transfer. In our example
we typed -2.00

The total amount in the Applied column will display in parentheses (2.00)

6. Click Save.
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Apply Credit

7. Click to highlight the visit to which the credit will be applied.
8. Click Add Adjustment button.
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9. Type adjustment code for balance transfer.
10. Type credit amount as shown in the Applied column. 2.00
11. Click Save.
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Add Charges Manually from New Charges Tab

Billing -> Patient Account -> New Charges Tab

Add a New Visit

Charges can be manually added by creating a New Visit from the New Charges Tab or they can be
manually added to a visit/encounter posted from the Billing Statements Tab in the Patient Chart. This
example will be Creating a New Visit
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1. Click the New Visit button

Add Rendering Provider of Service and Location/Place of Service to New Visit

New Visit dialog opens to begin adding charges.

 Prior to adding the charge/Procedure Codes, the Rendering Provider and the Location/Place of
Service will have to be selected.

2. Click the More Info button to add Provider of Service and Place of Service
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Add Other Info to Visit details including Workers Comp, Accident, Hospitalization and
Prior Authorization information

3. Using the Drop Down Arrow to display list of Providers that have been setup in SOAPware, Select
the Rendering Provider of Services.

4. Using the Drop Down Arrow to display the list of Facilities that have been setup in SOAPware, Select
the Place of Service from the list.
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5. If the New Charges are Accident related, require prior authorization, are related to a hospital visit,
etc., Type that information in the appropriate fields and enter dates that apply.

6. Click the Save button to save information

Add Charge in New Charges Tab

7. Click the Add Charge button to Open the Select Charge dialog

8. Begin typing the Charge code in the box or Click inside the Description to Search the code data
base. Click on the code from the list to insert it into the fields

9. Click on the Select button
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Add New Charge Details, including ICD-9/Diagnosis codes and Modifiers

Charge Details dialog will open for adding/editing New Charge. If a field is not grey/inavtivated, it can
be edited for corrections or changes

10.  Click the Add Code button to Add a Diagnosis/ICD-9 code to the New Charge. Begin Typing the
code or Click to search. When the correct code is in the field, Click the Select button or use the Enter
key on the keyboard to select a Diagnosis. Repeat as needed

11.  To Add a Modifier to the New Charge, Click the Add Code button. Begin Typing the code or Click
to search. When the correct code is in the field, Click the Select button or use the Enter key on the
keyboard to select a Modifier and Enter again to add another code. Repeat as needed.

12. Check this box if this charge is not going to be submitted to insurance.  

13. Enter additional Charge information if applicable in the Misc Details section. The Facility field will be
populated with the Facility selected in the More Info dialog. 
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14. Click the Save button to save data. 

Repeat Steps 7.-13. to add more charges

Post New Charges to Patient Ledger

14. If the patient is Self Pay and no insurance will be filed, Click the Drop Down arrow and select  Do
Not File-Patient Responsibility.

15. The Follow Up Action will default to Submit to Insurance. Click the Post button to apply charges to
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the Patient Ledger and automatically Create a claim for the new charges.

The Patient  Ledger Tab will open and the New charge(s) will be shown in the ledger. 
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More Visit Information

Billing -> Patient Account -> New Charges Tab ->More Info

Additional visit information is entered here including accident information, prior authorization numbers,
hospitalization dates, etc. 

More Info

1. Click the More button in New Charges Tab.

2. Enter information in the appropriate fields
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3. Click Save

Note: Current IIP will auto populate with the date selected for Accident, Last Menstrual Period or Onset
of Current. 
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Other Provider Information

Billing -> Patient Account -> New Charges Tab ->Add Charge -> Charge Details

Assign Ordering, Purchasing Service and Supervising Providers to charges/visits. 

Assign Additional Providers 

1. Click Add Charge button and enter charge code and double Click on the added charge to open
Charge Details dialog.

2. Click the drop down arrow and select from the available list of Contacts to assign the Purchasing
Service, Ordering or Supervising Provider.  

3. Click Save.
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Edit/Update Charges

Edit/Update Charges 

Charges can be Corrected/Edited from several different locations within SOAPware Billing. This
example shows a new charge in the New Charges Tab 

1. Double Click anywhere on the line item to Open the Charge Details dialog.

2. Click inside any editable field and make changes/corrections, as needed. 

3. Click the Save button to save changes
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Edit Diagnosis Code

1. To add a Diagnosis Code, Click the Add Code button and begin Typing the ICD-9 code or Click in
the Description search field and begin typing description. Click the Select button
2. Delete a code from the list by Clicking the X in front of the ICD-9 code
3. Change order of importance for diagnosis codes by Clicking on the Up and Down arrows to the right
of the code description.  

Edit Modifiers

1. To add a Modifier, Click the Add Code button and begin Typing the Modifier code or Click in the
Description search field and begin typing description. 
2. Click the Select button
3. Delete a Modifier from the list by Clicking the X in front of the Modifier
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Edit Procedure Codes

1. To change or add, Click to open the Select Charge dialog
2. Begin Typing the CPT code or Click inside the Description field and begin Typing a description for
the Code and select code from the list
3. Click the Select button 
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Addendum added to Patient Chart when Visits are Edited in Billing

When a visit is created in a Patient Chart and has been edited in Billing, an Addendum is created and
attached to the SOAP note section of the Patient Chart with a description of the changes
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Apply Payment to Patient Account in New Charges Tab

Apply Payment to New Charges 

Apply Payment to charges in the New Charges Tab at Checkout. Payments should be applied prior to
Posting new Charges to ledger. Payments can be applied to current charges and/or previous visits from
the Make Payment dialog. After current Charges are edited and verified for accuracy, Click the Add
Payment button to open Make Payment dialog.

Practice Management 2010.3 User Manual - 232



Apply Payment to New Charge

Payer Details Payer defaults to the Guarantor information, and can be edited to select a different payer

1. Payment Details Manual entry. Visits are inactivated until a Payment Amount is entered. Once an
amount is typed into the field, the payment can be applied to the charges

Select method to apply Payment:

2. Disburse To automatically apply this payment, Click the Disburse button. This will post to the oldest
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outstanding charge in the patient account and continue with the next oldest account until the entire
Payment amount is exhausted.  

3. Pay All To apply payment to all outstanding charges on account at one time, Click the Pay All
button. 

4. Pay Individual line item Charge To apply payment to current charge or selected charges, Click the
Arrow in the Applied Column. The payment amount will automatically populate the field, and can be
edited to spread the payment to other charges

Apply Payment to Visits/Charges

5. Apply Payment to Charges.This is a screenshot of one payment applied to two different charges. By
Clicking on the arrows in the applied column, $50 was applied to each charge. As the Payment is
applied, the Remaining amount is reduced by the applied amount.
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To make corrections, the Clear Applied button will remove current payments applied and reset the
Amount.

6. Click Save to return to the New Charges Tab and Post transaction to patients Ledger

Change Payer

In the Make Payment dialog, Payer will Default to the Patient information. If someone other than the
patient is remitting payment for the account, that information can be entered here for tracking
payments/refund information, etc.

To remove the payer and add a new one, Click the X next to the Payer name. 
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Create a New Payer

Click + to add a new Payer or ... to search existing list of Payer/Non Patient accounts

New Payer details

Enter Payer details and then Click the Save button
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Add Payment Details

1. Enter Payment details including Payment method and amount of payment. As you type the payment
amount, the lower portion listing the patient visits is activated. 

2.  If a Guarantor/Payer payment is to be applied to additional patients in the system, Click the Add
Patient button or select a dependent from the Add Dependent list

3. Apply payment amount to several charges with one click. Payment will be applied to charges
beginning with the oldest outstanding balance
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Apply Co-Pay/Pre-Pay to Visit

Apply Co-Pay/Pre-Pay to visit at check in

 When a Co-Pay is taken by the front desk at the time a patient checks in and saves it in the Make
Payment Dialog, it will be saved in the Unapplied Co-Pay section in the New Charges Tab. The
Screenshot in this step is how the New Charges Tab will appear at Checkout after the Visit has been
posted to billing from the Chart section. 
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1. Click the Apply Co-Pay button to open Unapplied Co-Pay dialog.
 

2. Click the Disburse button. Co-Pay amount must be included in the patient Insurance Demographics
to activate the Disburse button.
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The amount in the Unapplied Co-Pay box should automatically populate the current visit. This can be
edited to place the payment on any outstanding visit, if needed. 

3. When the Co-Pay amount is applied to the selected visit, Click the Save button.
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New Charges dialog opens. The Unapplied Co-Pay is zero, the payment is applied to the new charge
and the Balance reflects the Payment.

4. Click the Post button to post transaction to the Patients Ledger.
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Delete Co-Pay From Patient Ledger

1. Click Ledger Tab.

2. Locate the payment line item and Click the X next to the Posted date.

3. Click Yes to put the payment back into the Co-Pay Unapplied Amount and allow the user to reapply
the Co-Pay to the correct visit/charge. 

4. Click No to remove the payment from the system. 

5. Click  Cancel to cancel the delete process and return to Ledger details.

Note: Only users with security privileges will be allow to delete a payment. 
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Delete a Co-Pay from visit 

1. Click Ledger Tab.

2. Locate the payment line item and Click the X next to the Posted date.

3. Click Yes to put the payment back into the Co-Pay Unapplied Amount and allow the user to reapply
the Co-Pay to the correct visit/charge. 

4. Click No to remove the payment from the system. 

5. Click  Cancel to cancel the delete process and return to Ledger details.

Note: Only users with security privileges will be allow to delete a payment. 
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Spread One Payment to Multiple Dependents

Pay multiple patient/dependent accounts from an Active Patient Account in the Make Payment dialog .
Click on the Make Payment button found in several sections within the Patient Account. 

Select Dependents for Payment

If the Payer shown in the Payer Details section wants to pay additional patient/dependent accounts
within the system, those payments can be applied from one dependent's account in the Make Payment
dialog. If the Payer has dependents set up in the Family Tab, they will be in the drop down Add
Dependent list. If not, the patient can be accessed by Clicking the Add Patient button and selecting a
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patient from the Chart Rack.

1. Click the Drop down option to select another patient/dependent from the Payer's Family Tab.  

Apply Payment to Dependent(s)

This example shows a $100.00 Payment to be distributed between 2 Patient Accounts. The active
patient will be listed first and the additional dependent(s) will be listed next.

2. Click the arrow in the Applied column on the charge line item, and type payment amount for the first
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patient listed.

3. Repeat for the next patient listed. 

As payments are applied, the  Remaining amount is reduced until all has been distributed and then the
remaining will be zero. The Clear Applied button will remove all applied amounts allowing corrections
to be made prior to Saving the transaction

4. Click Save to return to the New Charges Tab and Post transaction to Ledger
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Patient Ledger
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View Charges in Ledger

View charge details in patient account ledger

Select a Charge to View

1. Double Click on the Charge line item to open the Charge Detail dialog
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Charge Details

2. View details for selected claim including Service dates, codes used when charging the service and
miscellaneous

3. Summary of Payments and Adjustments applied to selected Charge

4. Details of Insurance payments and adjustments applied to selected Charge. If insurance has not
processed the claim this section will be closed. To view additional Insurance Payment details, Double
Click the Payment as shown in step 3. This will open the Insurance Payment details dialog
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The Insurance Payment Details dialog displays additional Remittance/Insurance payment details
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Create a Claim from Ledger

If a claim has never been created for charges and insurance information is later added to patient
demographics, create a claim from the patient ledger to submit to the payer.

1. Open patient account and Click on the Ledger tab.
2. Click the Create Claim button to open Create Claim dialog.

Practice Management 2010.3 User Manual - 251



Select Charges to create a claim

3. Click to highlight and select the visit for which you wish to create a claim.
4. Click the drop down arrow to open listing of all insurance companies associated with the patient,
including active or inactive policies.
5. Click to highlight and select the payer responsible for the selected visit.
6. If you wish to open the Claims Manager after creating claim, place a check in the box.
7. Click Create button.

Claim(s) will be transferred to the Claims Manager Pending Scrub section to be scrubbed and then
submitted to the payers.
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View Personal Payments in Ledger

View details of personal payments from the Patient Ledger

1. Double Click on the Personal Payment line item to open the payment dialog details
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Payment Detail dialog opens showing all the details of the selected payment, including the charge to
which the payment was applied.

2. Click the Close button
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View Insurance Payment Details from Ledger

View Insurance Payment Details from the Ledger Tab

1. Double Click on the Insurance Payment line item.
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Insurance Payment details dialog opens listing all patient claims to which this payment was applied. 

2. Click on the first Claim line item. The Claim details section breaks down the charges that make up
the claim and list the amount paid to the Provider.

3. Click Close.
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4. Repeat for each item listed in the Claims section as needed
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Print Receipt/Statement by date range from Ledger

Print a Receipt/Statement from the Patient Ledger Tab. Select by date or a date range. Select by
Posted Date or Date of Service. This report can be Previewed and/or Printed

1. Click the Print Receipt button
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Select Receipt From Date/To Date

2. Select a Date or Range of dates from the Print Receipt dialog.

3. Choose to generate the receipt by the date the transaction was Posted or by the Date of Service.

4. Click the Print button to open Print Preview
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Print Receipt/Statement

5. Click the printer icon to print or select one of the other options shown on the ribbon bar.
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Add Charges in Ledger

Add Custom Charges to patient account from within the Ledger Tab. Select Patient Account from Chart
Rack and Click on the Ledger Tab

Note: Charges entered from the Ledger Tab will not be sent to the Claims Manager and submitted to
Insurance. This option is for miscellaneous items unrelated to CPT or HCPCS charges

Add Charges in Ledger Tab

1. Click the Add Charge button. Select Charge dialog opens
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2. Begin Typing Charge Code or Search by Code number or Description. Search includes Custom
Charge Maintenance codes and CPT/HCPCS codes and must be included in the Default Fee Schedule
to populate the Charge amount. 

3. Click the Select button to add charge to ledger
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View Charge in Ledger

New Charge is added to ledger. If the Charge amount is blank, the code has not been setup in the
default fee schedule amount. You can manually add the amount by Double Clicking on the line item
and Typing the charge amount in the Charge Details dialog
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Add Payment in Patient Ledger

Apply Payment to Patient Ledger

1. Click the Add Payment button to open Make Payment dialog.
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2. Type payment details.

3. Apply payment to charges:
Disburse: Will auto disburse payment (older to most current charges).
Pay all: Will auto apply Amount to all outstanding charges.
Or you can manually apply payment to selected charge by clicking on the arrow in the Applied column
(Red Arrow).
When entire amount is applied, Remaining balance will be $0.00

4. If receipt is requested place a checkmark in the box next to Print Receipt and Click Save.
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If errors are made, click Clear Applied to remove applied amount(s).
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Print Receipt for Payment in Ledger

Apply a personal payment from patient ledger and print a receipt. Receipt for payment now showing
more details. For this lesson, we will apply a payment made by a Payer/Non-Patient to three separate
dependents accounts from one dependent account.

Apply Payment to multiple dependents from ledger

1. Click on Ledger tab in patient account.

2. Click on Add Payment.
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Select multiple dependent accounts

3. Verify payer name.

4. Enter payment details.

5. Click Add Patient. Select dependent from chart rack and repeat for each dependent.
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Apply payment to each dependent visit

6. Click inside the grid in Applied column to apply payment to charge and repeat for each dependent
account.
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Print a receipt for personal payment made in patient ledger

 When a payment is applied to an account from the ledger, the Print Receipt after Saving will be
checked by default. If a printed receipt is not necessary, click inside the box and leave blank.
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Delete Personal Payment

Patient Account -> Ledger Tab

Open the Patient Ledger Tab and click the X on the payment line. You will be required to Confirm
Delete. Yes will Delete and No will Cancel.

Note: Users must have security privileges to delete a payment.
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Delete an insurance payment from visit

Deleting an insurance payment from a patient ledger will also delete all other payments included on the
remit, and will produce two prompts to confirm that you wish to delete.

Deleting an insurance payment from a patient visit

Warning! Deleting an insurance payment will delete payment for all patients included on the posted
remit. This action cannot be undone. 

1. Click the X next to the Post date for the payment that will be deleted.

2. Click Yes to continue deleting the payment. A message box will warn that deleting an insurance
payment will delete all payments for all patients included in the remittance. You will prompted a second
time to confirm Delete.
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3. Click No to Cancel the deleting  process.
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Add Adjustment in Ledger

Located in Billing -> Patient Account -> Ledger Tab

Add an Adjustment to Patient Account from the Ledger

Select Patient from the Chart Rack and Click on the Ledger Tab to View Account Details

1. Click the Add Adjustment button to Open the Select Adjustment dialog
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Select Adjustment Code

2. Access the list of Adjustment Codes and descriptions in Adjustment Maintenance by Clicking the
Code or Description drop down arrow

3. Click to Select the applicable Adjustment in the list. This will activate the account details in the lower
section 
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Apply Adjustment to Charge

4. Click the arrow on the line item to select charge to apply adjustment. The amount will default to the
charge balance amount, but can be edited

5. Type Adjustment amount in field. 

6. Click the Okay button
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View Applied Adjustment

Adjustment Code, Description and amount is added to the Ledger and the Charge/Service line item that
the adjustment was applied to with the new charge and account balance reflecting the Adjustment
amount.
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Payer/Non-Patient Accounts
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Add a Payer/Non-Patient Account

Go to Billing -> Payer/Non-Patient Account

Create a New Payer/Guarantor

Click on Billing from the main menu and Click Payer/Non-Patient Account to open Non Patient
Accounts Lookup.

1. Click on the Create New Payer icon.
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2. Complete payer information and Click Save.
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Add Payer/Non-Patient Account in Demographics

Billing -> Patient Account -> Demographics Tab

1. Open Patient account and Click on the Demographics tab. 
2. Click Create a Non Patient Guarantor to open the New Payer dialog. 
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Enter Payer information and click Save. Guarantor/Payer name will populate the Guarantor field.
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Add Dependents to Payer Account

3. Click the arrow next to Guarantor name to open Guarantor Demographics.  

4. Click the Family Tab. The active patient will display in the Dependent list.

5. Click Add Dependent to add additional patients to this payer if needed. 
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Add Dependents to Payer/Non-Patient Account

Add Dependents to Payer Account

3. Click the arrow next to Guarantor name to open Guarantor Demographics.  

4. Click the Family Tab. The active patient will display in the Dependent list.

5. Click Add Dependent to add additional patients to this payer if needed. 
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Change Payer/Guarantor in Make Payment dialog

Billing -> Patient Account -> Ledger tab -> Add Payment or Billing -> Patient Account -> New Charges
tab-> Add Payment 
 

Add Payer from Patient Ledger

1. Click the Add Payment button to open Make Payment dialog.
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Payer name will default to Patient unless a Guarantor has been specified in Patient Demographics.

2. Click X next to current Payer name in Payer Details section of Make Payment Dialog. The field will
be cleared.

3. Click button to select a different payer from Select Payer dialog.
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Enter Charges
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Enter Charges from Billing Menu

Main menu -> Billing -> Enter Charges

1. Click Enter Charges to open the Chart Rack. Select a patient from the chart rack and the patient
account will open to the New Charges tab 
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Add a New Visit

Charges can be manually added by creating a New Visit from the New Charges Tab or they can be
manually added to a visit/encounter posted from the Billing Statements Tab in the Patient Chart. For
this example, a New Visit will be created in the Patient Account-New Charges Tab

2. Click the New Visit button
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Add Rendering Provider of Service and Location/Place of Service to New Visit

New Visit dialog opens to begin adding charges.

 Prior to adding the charge/Procedure Codes, the Rendering Provider and the Location/Place of
Service will have to be selected.

3. Click the More Info button to add Provider of Service and Place of Service
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Add Other Info to Visit details including Workers Comp, Accident, Hospitalization and
Prior Authorization information

4. Using the Drop Down Arrow to display list of Providers that have been setup in SOAPware, Select
the Rendering Provider of Services.

5. Using the Drop Down Arrow to display the list of Facilities that have been setup in SOAPware, Select
the Place of Service from the list.

6. If the New Charges are Accident related, require prior authorization, are related to a hospital visit,
etc., Type that information in the appropriate fields and enter dates that apply.

7. Click the Save button to save information
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Add Charge in New Charges Tab

8. Click the Add Charge button to Open the Select Charge dialog

9. Begin typing the Charge code in the box or Click inside the Description to Search the code data
base. Click on the code from the list to insert it into the fields

10. Click on the Select button
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Add New Charge Details, including ICD-9/Diagnosis codes and Modifiers

Charge Details dialog will open for adding/editing New Charge. If a field is not grey/inavtivated, it can
be edited for corrections or changes

11.  Click the Add Code button to Add a Diagnosis/ICD-9 code to the New Charge. Begin Typing the
code or Click to search. When the correct code is in the field, Click the Select button or use the Enter
key on the keyboard to select a Diagnosis. Repeat as needed

12.  To Add a Modifier to the New Charge, Click the Add Code button. Begin Typing the code or Click
to search. When the correct code is in the field, Click the Select button or use the Enter key on the
keyboard to select a Modifier and Enter again to add another code. Repeat as needed.

13. Enter additional Charge information if applicable in the Misc Details section. The Facility field will be
populated with the Facility selected in the More Info dialog. 

14. Click the Save button to save data. 
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Repeat Steps 8-14 to add more charges

Post New Charges to Patient Ledger

15. If the patient is Self Pay and no insurance will be filed, Click the Drop Down arrow and select  Do
Not File-Patient Responsibility.

16. The Follow Up Action will default to Submit to Insurance. Click the Post button to apply charges to
the Patient Ledger and automatically Create a claim for the new charges.
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The Patient  Ledger Tab will open and the New charge(s) will be shown in the ledger. 
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Enter Payments
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Add Personal Payments from Billing Menu

Main Menu -> Billing -> Enter Payments

Apply personal payments to patient accounts. Make Payment dialog can also be accessed in the New
Charges tab and the patient account Ledger. To apply Insurance Payments to accounts, see Post
Insurance Payments.

1. Click on the Enter Payments menu option to open the Chart Rack. Select a Patient from the Chart
Rack and the Make Payment dialog will open.
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2. Type payment details.

3. Apply payment to charges:
Disburse: Will auto disburse payment (older to most current charges).
Pay all: Will auto apply Amount to all outstanding charges.
Or you can manually apply payment to selected charge by clicking on the arrow in the Applied column
(Red Arrow).
When entire amount is applied, Remaining balance will be $0.00

4. If receipt is requested place a checkmark in the box next to Print Receipt and Click Save.
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If errors are made, click Clear Applied to remove applied amount(s).
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Claims Manager
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General Work flow-Claims Manager

Billing -> Claims Manager

 An Insurance Claim cannot be created unless insurance information has been entered in Patient
Account Insurance Demographics tab. 

 
 Paper claims are identified by the Icon in the first column. Electronic claims are blank. 

1. When a charge is posted to the Ledger from the New Charges tab, an insurance claim is created.
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The claim is automatically inserted into the Pending Scrub section of the Claims Manager.

2. Claims are Scrubbed and placed in the Ready to Process section. If the claim needs to be corrected
or edited, the claim will be placed in the On Hold section with a reason for rejection.

3. Once the claims are corrected and reprocessed/rebuilt to apply changes, they are Scrubbed again
and moved to the Ready to Process section. If a claim is still getting placed in the On Hold section
when Scrubbed, this will have to be repeated until the claim is error free and moved to the Ready to
Process section.

4. When the Claims are Ready to Process, they are exported to the designated file for submission to
the Receiver or Printed to a CMS 1500 claim form to be mailed to the Payer.

Note: Select a single Claim by Clicking the claim to highlight. To select random claims, Click on a Claim
and while holding down the Ctrl key, left click on other claims to highlight. To Select all claims in a
section, Click on the first claim to highlight and while holding down the Shift key, Click on the last claim
to highlight those two and all the claims in between.

Column Headers

Posted: Date Claim was posted to the patient ledger and claim was created
Claim: Claim number used for identification and tracking. This number is automatically assigned when
the claim is created
Physician: Performing Provider 
Patient: Patient name
Primary: Identifies patient's Primary Payer
PRT: Primary Payer Routing (Paper claim or Electronically sent)
Secondary: Identifies patient's Secondary Payer
SRT: Secondary Payer Routing (Paper claim or Electronically sent)
Amont: Total amount of claim
File With: Filing claim with (Primary or Secondary)
Submission: Indicates to Payer if the claim is Original claim, Corrected claim, Replacement claim or a
Voided claim
Status: Status of claim (On Hold, Pending Scrub or Ready to Submit)
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Hold Notes: Hold notes gives a short explanation of why the claim is being placed in the On Hold
section. This note will be attached if the claim is rejected in the Scrub process. It can also be typed by
clicking in the grid if the claim is manually placed on hold by user
Claim Notes: Claim notes are automatically added when a claim is set to Refile, has been Rebuilt, etc. 
It can also be typed by clicking in the grid if needed.  

Hold notes and Claim notes are for user reference only. Notes are not included on claims
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Scrubbing Claims

Patient accounts with Insurance information entered into the Insurance Demographics section of the
Chart will automatically produce a claim when new charges are Posted to the Patient Ledger, and those
claims will be placed in the Pending section of the Claims Manager. Claims can be selected for
Scrubbing one at a time or random claims or all claims. 

1. Click on the claim line to highlight.

To select random claims, Click on a Claim and while holding down the Ctrl key, left click on other claims
to highlight. To Select all claims in a section, Click on the first claim to highlight and while holding down
the Shilft key, Click on the last claim to highlight those two and all the claims in between. This example
shows all claims selected

2. Click the Scrub button. Claims will be moved to the Ready To Process section. If the scrubber finds
an error on any claims, those claims will be moved to the On Hold section with a description of the error.

Note the Claim number 257 in the red box. This lesson will track that claim from Pending Scrub to
Submitting claim.

Insurance remittance/response will use this claim number in the Patient Account section of the EOB to
identify the patient.

Practice Management 2010.3 User Manual - 304



Claims will be moved to the Ready To Process section unless the scrubber finds error(s) on a claim as
shown in this screenshot. Claims with errors will be moved to the On Hold section to be
edited/corrected, with a description of the error as seen in this screen shot. 

3. Click Ok. The error dialog will continue to prompt you to click OK for each claim that has errors until
all selected claims have been scrubbed.
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Scrubber Errors-How to Correct and Rebuild Claim

If the Scrubbing process finds a claim with errors/incomplete information, a Scrub Error message will
pop up and the claim will automatically be moved to the On Hold section of Claims Manager. 

This lesson will describe the errors and list the steps to correct the error(s). The Claim will then have to
be Rebuilt to apply the corrections, and Scrubbed again. When the claim has passed the scrubbing
process, it will be automatically moved to the Ready to Submit section. 

Note: Edits/Corrections will not be applied to claims unless the Rebuild process is performed. 

Scrub Errors 

1. Click the OK button in the message box. 

2. In the On Hold section of the Claims Manager, Double Click anywhere on the claim line to open 
Patient Account and make corrections as listed in the following steps.

 After corrections are made, Close the Patient Account, return to Claims Manager and Rebuild claim
to apply changes.
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Patient is missing part of their demographics- Invalid Date of  Birth

Verify patients demographics are correct: date of birth, address, phone, etc.
 
3.    Click the Demographics Tab.
4.    Correct the Birth Date.

Return to Claims Manager and Rebuild claim to apply changes.
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The Primary insured is missing part or all of their demographics 

Verify insured info 

1.    Find the claim getting rejected in the On Hold section of Claims Manager and Double Click inside
the grid to open Patient account. Click the Insurance tab. 
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2.    Click View next to the insurance company getting the error
3.    Check each field in the Insured Information section and verify that it matches information exactly as
it appears on insurance card, including the Patients relation to insured.

Return to Claims Manager and Rebuild claim to apply changes.

Primary Insurance Company Missing Data

Check Insurance Company setup

1.    Find the claim getting rejected in On Hold section of Claims Manager and find the Payer
name-Primary column or Secondary column, depending on filing status
2.    Go to Tools -> Insurance Company.
3.    Find the Insurance Company/Payer within the list and Click the Edit Icon.

Practice Management 2010.3 User Manual - 309



4.    Add missing info.
5.    Click OK

Return to Claims Manager and Rebuild claim to apply changes.

Secondary Insurance Company Missing Data

Check Insurance Company setup

1.    Find the claim getting rejected in On Hold section of Claims Manager and find the Payer
name-Primary column or Secondary column, depending on filing status Go to Tools -> Insurance
Company.
2.    Find Insurance Company in Insurance Company Manager and Click the Edit Icon.
3.    Add missing info.
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4.    Click OK

Return to Claims Manager and Rebuild claim to apply changes.

The line items are missing part or all of their detail-CPT/HCPCS Code

Edit Charge Details

1.    Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside the
Grid to open Patient Account.
2.    From the Claims tab, click the claim getting the error to open it in Claim Details.
3. Double Click on the line item to open the Charge Details.
4.    Add appropriate Codes in the Code field. Repeat for each line item in Claim Details section.
5.    Click Save. 

Return to Claims Manager and Rebuild claim to apply changes.
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The line items are missing part or all of their detail-Units

Edit Charge Details

1.    Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside the
Grid to open Patient Account.
2.    From the Claims tab, click the claim getting the error to open it in Claim Details.
3. Double Click on the line item to open the Charge Details.
4.    Add appropriate number in the  Units field. Repeat for each line item in Claim Details section.
5.    Click Save. 

Return to Claims Manager and Rebuild claim to apply changes.
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The Provider is missing part or all of their information

Verify Rendering Provider information in Provider Manager

1.    Find the claim getting rejected in the On Hold section of Claims Manager and Check for Provider
name in the Provider column. 
 
2.    Go to Tools -> Provider Manager and verify correct info is entered in all fields. 

3. Add missing data and Click Update. 

If there is not a Provider shown in the Provider Column, see next step
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The Provider is missing part or all of their information-No Provider selected

1.    Double Click on the line of the claim getting the error to open the Charge Details. 
2.    From the Claim Details, double click on the claim getting the error  to open the Charge Details.
3.    Use the drop down list to add the Rendering Provider in the Provider field.
4.    Repeat for each line item on the claim.

Return to Claims Manager and Rebuild claim to apply changes.
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The Referring provider is missing part or all of the information

Verify Referring Physician info is entered correctly in Contacts

1.    Find the claim getting rejected in the On Hold section of Claims Manager and Double Click inside
the grid to open Patient account. Click the Demographics tab. 
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2.    Check the name of the Referring Provider.
3.    Go to Tools -> Contacts and Click to highlight/select Referring Provider from the list.
4.    Click the Edit icon to Edit Contact Information.
5.  Verify Provider information is included in each required field. Name and NPI numbers are required

Return to Claims Manager and Rebuild claim to apply changes.

The Provider is missing all or part of the signature

Verify Rendering Provider Signature is loaded

1.    Find the claim getting rejected in the On Hold section of Claims Manager and check the Physician
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column to find the name of the Rendering Physician.
2.    Go to Tools -> Provider Manager and select that physician from the list of Providers.
3.    Click on the Signature tab and make sure signature is selected. (See Provider Manager setup in
Billing Maintenance)
4.    Click Update.

Return to Claims Manager and Rebuild claim to apply changes.

The Facility is missing part or all of its address information

Verify POS/Place of service

1.    Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside the
Grid to open Patient Account.
2.    From the Claims tab, make sure the rejected claim is displayed in Claim Details and Double Click
to open the Charge Details.
3.    Add the correct Facility in the Misc. Details section of Charge Details dialog.
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4.    Click Save.
5.  Repeat for each line item on the claim.

Return to Claims Manager and Rebuild claim to apply changes.

The Facility is missing part or all of its information

Check Facility Setup 

1.     Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside the
Grid to open Patient Account.
2.    From the Claims tab, make sure the rejected claim is displayed in Claim Details and Double Click
to open the Charge Details.
3.    Check the Facility in the Misc. Details section of Charge Details dialog as shown in the previous
step.
4.    Go to Tools -> Manage Facilities and select the Facility from the list. 
5. Click the Edit icon.
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6. Verify required information, including Facility NPI# is in facility Details tab.

7. Click Update to save changes. 

Return to Claims Manager and Rebuild claim to apply changes. 
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When a  diagnosis is between 800 and 999.9, Accident info is needed  

Add accident information to More Info dialog 

1. Find the claim getting rejected in On Hold section of Claims Manager and Double Click to open
Patient Account.
2.    Verify the rejected claim is displayed in Claim Details (bottom section) of the Claims tab.
3. Click the More Info button.
4. Add the Type of Accident in Edit Claim Details dialog
5. Add the Date of Illness, Injury or Pregnancy.
6. Click Save.

Return to Claims Manager and Rebuild claim to apply changes.
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When auto accident is selected a state must be selected  

Add accident State and/or Date of Current to More Info dialog

1.    Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside the
Grid to open Patient Account.
2.    Verify the rejected claim is displayed in Claim Details (bottom section) of the Claims tab.
3. Click the More Info button.
4. Click on the drop down list and select State in which the accident occurred.
5. Click Save.

Return to Claims Manager and Rebuild claim to apply changes.
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At least one diagnosis must be entered for the charges.  

Add diagnosis code(s) to claim

1.    Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside the
Grid to open Patient Account.
2.    From the Claims tab, verify the rejected claim is displayed in Claim Details (bottom section) and
Double Click the claim to open Charge Details dialog.
3. Click Add Code in the Diagnosis Codes section.
4. Click Save. 
5. Repeat for each line item on the claim.

Return to Claims Manager and Rebuild claim to apply changes.
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A Charge information is missing or incorrect

Verify correct date of service is associated with charges

1.    Find the claim getting rejected in On Hold section of Claims Manager and Double Click inside the
Grid to open Patient Account.
2.    From the Claims tab, verify the rejected claim is displayed in Claim Details (bottom section) and
Double Click the claim to open Charge Details dialog.
3.    Edit/Add the correct date of service in the Service From and Service To fields.
4. Click Save. 
5.    Repeat for each line item on the claim.

Return to Claims Manager and Rebuild claim to apply changes.
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The line item is missing all or part of their information

Verify Rendering Provider setup includes NPI information

1.    Find the claim getting rejected in the On Hold section of Claims Manager and check the Physician
column to find the name of the Rendering Physician.
2.    Go to Tools -> Provider Manager and select the physician from the list of Providers.
3.    Click the General tab and verify correct NPI is entered in the Physician numbers section.
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Return to Claims Manager and Rebuild claim to apply changes. 

Missing/Invalid Taxonomy Code

Verify Taxonomy Code in setup

In the On Hold section of the Claims Manager, find the claim with the error and check the Physician
column to find the name of the Rendering Physician

1. Go to Tools ->  Insurance Companies.
2. Highlight the Insurance company rejecting the claim. 
3. Click  the Edit Insurance Company icon
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3. Click the Rendering/Performing Provider from the list in the Provider Setup section. 
4. Click the Edit icon to open the Edit Billing Information dialog.
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5.    If the Group Taxonomy is missing, make sure the Legacy ID in the insurance Payment To 
section has Provider Taxonomy-ZZ and that the correct Taxonomy Code is entered.

6.    For the Rendering Provider rejection, verify that the Legacy ID is Provider Taxonomy-ZZ and
that the correct Taxonomy Code is entered in the Rendering Information section. For a list of
Taxonomy Codes Click on  the link below.

http://www.wpc-edi.com/content/view/793/1

Return to Claims Manager and Rebuild claim to apply changes.
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On Hold

After the Scrubbing Process, Claims that have error(s) will be placed in the On Hold section of the
Claims Manager where they can be edited and then Scrubbed again for any further errors prior to
Submitting to the Payer. This example lists three claims that are missing diagnosis codes.

1. Double click on the first claim to open the Claim Details in Patient Account. 
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Edit Claim

The Claim Details section allows access to all details of the claim in error to correct and Rebuild the
claim before repeat the Scrubbing process. Note the Claim number in the screenshot is 86. A number is
assigned to each claim as the claim is created for identification. That number can be found in the Claim
ID column in the Claims Manager. Editing can be done by Clicking on the More Info button or by
Double Clicking on the line of the Charge.

2. Double Click on the charge to access Charge Details 
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The Charge Details dialog allows for editing most charge related errors. Fields can be edited by clicking
on the drop down arrows or Clicking the buttons.

3.To add a Diagnosis code, Click the Add Code button.

4. Select diagnosis code from Select Diagnosis dialog that opens

5. Click Save
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To add or edit additional information needed to correct a claim Click the More Info button.
5. Add accident type
6. Edit Workers Compensation dates, Hospitalization dates
7. Date of Illness, Injury or Pregnancy
8. Original Reference/Prior Authorization/Medicaid Resubmission numbers

Click the Save button to save changes. After completing the corrections/editing, Close out of the
Patient Account Claims Tab

After closing out of the Claims Tab, the Claims Manager will open. Repeat steps 5-8, or those steps
applicable to the errors, until all claims you wish to correct/edit are completed.
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9. Click to Select one or more corrected claim(s)

10. Click the Rebuild button. The claim(s) are moved to the Pending Scrub section to Scrub after
corrections.
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Ready To Submit

Claims in the Claim Manager that have been scrubbed and are ready to submit to the Payer will be
moved to the Ready to Process section

When a claim has passed the Scrubbing Process, has no errors and is moved to the Ready to Process
section, it is ready to submit to the Payer. 

New in SOAPware 2010.3: Clicking the Generate Electronic  or Submit Selected buttons will
automatically upload electronic claims to the specified clearinghous/receiver.

1. Select one or more claims to submit to Payer.

2. To submit only the Electronic claims in the Ready to Process section, Click the Generate Electronic
button

3. To Print only the Paper Claims in the Ready to Process section, Click the Print Claims button

4. To submit some but not all claims, click to highlight the claims and then click the Submit Selected
button.
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Submitted Tab

The Submitted Tab lists all Claims that have been Submitted to Payers. Claims can be searched by
Date Range and the information listed in the columns can be sorted by clicking on the column headers. 
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Resubmit Rejected Claims  

Billing -> Claims Manager -> Submitted Tab

Edit claims that have been submitted to Clearinghouse or Receiver and rejected with errors prior to
submission to Payers.

Select Claim for Correction

1. Click the Submitted tab, double click a claim to open Claims tab in Patient Account..
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Edit Claim

1. If rejection is for Visit information, click the More Info button. 

2. If rejection is connected to Charge details, double click the line item in Claim Details section of the
Claims tab.
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Edit Charge Details  

This is an example of a claim rejected for having more than four diagnosis codes per Procedure Code.
Other edits/corrections can be made by clicking inside the applicable fields/sections.

3. Click to highlight the Diagnosis Code that is to be deleted. 

4. Click the X  to delete the code. Repeat for any additional diagnosis code to be deleted.

5. Click Save and then Close patient account to return to Claims Manager.

Repeat steps 1-5 for each claim that has been rejected. 
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Rebuild Claims

6. After all claims have been edited/corrected, Click the Rebuild button for each to apply changes to
the claim.  

This process will automatically move the claim to the Pending Scrub section in the Working tab.
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Scrub Corrected Claims

7. Click to highlight the corrected claims.

8. Click Scrub.
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Submit Corrected Claims

9. Click to highlight Corrected claims.

10. Click Submit Selected.
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After claims have been exported, follow the usual procedure to Upload claims to Clearinghouse or
Receiver.
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Rebuild Multiple Claims at one time

Rebuild an entire claim file or multiple claims at one time to resubmit to payers. 

Rebuild Selected Claims

1. Click on the Submitted tab.

2. Select claims by Clicking on the first one and while holding down the Shift key Click on the last claim.
This will highlight those claims and all claims in between. Or hold down the Ctrl key and select multiple
claims one at a time.

3. Click the drop down arrow next to Rebuild Selected button and add a note for rebuild reason, if
needed. The comment will display in claim details for reference. 

4. Click Rebuild Selected button.
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5. You will be prompted to confirm rebuilding the number of claims selected. Click Yes to continue or
No to cancel. Claims will be transferred to the Pending Scrub section in the Working tab.
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Scrub and Submit Rebuilt claims

6. Select claims to scrub and Click Scrub.

7.  Select claims to Submit and Click Submit Selected.
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Refile a Claim

Refile a Claim from Submitted Tab

Claims can be refiled or placed on hold from the Submitted Tab within the Claims Manager

1. Double Click on the claim to open Claim Details dialog. Follow the steps to edit claims as instructed
in the On Hold lesson. 

2. After editing claim, click the Rebuild button to open Rebuild notes dialog. Type notes pertaining to
the refile, if applicable.

3. Click on the Rebuild button within the notes dialog. Changes will be added to claim and the claim will
be placed in the Pending Scrub section of the Claims Manager.

Claim Notes will reflect the date the claim was rebuilt and any notes. Rebuilt claim is ready to be 
Scrubbed and Submitted to Payer. See Scrubbing Claims and Ready to Submit
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Omit a charge from claim when refiling  

Omit a paid procedure from a claim when resubmitting unpaid charges to insurance.

Billing -> Post Insurance Payments

Refile only denied charges to Insurance

1. Comment Reason for denial 

2. Apply payment amount to paid charge(s).
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3. Set Next Action to Refile.

4. Double Click on line of paid charge(s) to open Charge Details.

Omit Paid Charges

5. Place a check mark to Omit from Claim.

6. Click Save.
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Post Payment to ledger

7. Save Claim and then Post Payment to ledger. Claim will move to Pending Scrub section of Claims
Manager.

Practice Management 2010.3 User Manual - 348



Rebuild Claim

Go to Billing -> Claims Manager

8.   Locate claim in Claims manager. Change Claim Status to On Hold  

9.   Rebuild Claim to save claim changes.

10. Submit Selected to Resubmit claim.

Note: If not ready to resubmit claim, it can be put On Hold, Rebuild, Scrub and leave in Ready to
Submit section until time to upload file.
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Secondary Claims

Secondary claims will automatically be moved to the Pending Scrub section if the Claims Manager
once the primary insurance payment is applied to the visit and File Secondary-paper is selected for the
Next Action.

New for SOAPware 2010.3: When a secondary claim is printed, it will now be populated with the
information from the secondary insurance demographics instead of a duplicate of the primary insurance
claim.

Set Secondary Claims to process

1. When posting primary insurance to a visit, make sure the Next Action selected is File
Secondary-Paper.

2. Save Claim.
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Scrub Secondary Claim 

2. Locate the secondary claim highlight. 

3. Click on the PDF icon if you wish to view the claim.

4. Click the Scrub button to check for errors.

Print Secondary Claim

4. Click the Print Claims button. All paper claims in the Ready to Submit section will print.

5. Click to highlight a single claim and then click the Submit Selected button. Only the highlighted claim
will print. 
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All Tab

The All Tab lists all claims in the Working and Submitted tabs and the current status of the claim.
Claims can be searched by Date Range and the information listed in the columns can be sorted by
clicking on the column headers. 
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Posting Insurance Payments
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Introduction to Insurance Payment Posting

Introduction to Insurance Payment Posting 

Create/Load Payment Detail is manually entered using information from the Remittance/EOB.
 
Patient Details Displays patient information from the General Demographics section and
Patient/Family Balances from the Patient Ledger

Claims Lists Outstanding/Unpaid insurance claims for the Patient, the status of the Claim and details
pertaining to the claim. To include paid claims in the list, place a check mark in the box next to Show
All Claims

Claim Details Populated with information pertaining to the claim. Payment information is manually
added with information from the remit/EOB
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Charges Breaks down the individual charges/services that are included in the selected visit/claim.
Double Click on a line item to view Charge Details

Select Claim/Visit for Payment

Outstanding claims are listed in the Claims section of the Posting window. If a claim is highlighted, the
lower section of the window displays each line item/charge that makes up the selected claim. Details in
both the Claims and Charges sections can be sorted by Clicking on the column headers. 

1. Click inside the Claim grid to select a claim for payment.
 
2. Details of the selected claim will display in the Charges section of the window.
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Enter Claim Details using Remit/EOB

The Claim Details section displays various details entered when charging the selected claim, including
miscellaneous accident/illness info. This information cannot be edited.  Payment information is entered
using details from the Insurance Remittance.

3.  Type Total Payment amount for the selected claim. An alert will show if an amount more than the
remaining amount of the check is entered

4. Type Claim Control number from Remit for informational/tracking purposes

5. Enter total amount that is the responsibility of the insured/patient as shown on Remit

Apply Payment to Charges

The payment is ready to be applied to the charges. Note that the Remaining Balance amount is the
same as the Payment Amount and will decrease as payments are applied to the line items. When the
last payment is applied to the final charge, the Remaining Balance should be zero.

6. Match the remit payment to the correct charge by verifying Begin and End dates, Procedure code
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and Amount Billed.

7. Click on the line of the charge inside the Allowed Column and enter the amount shown on the EOB
as the Allowed amount.

8. Tab to the next column and enter any amount that was applied to the deductible, CoInsurance, etc
and then finally enter the payment amount that was paid for the line item charge and repeat until the
remaining Balance is zero, all charges for the selected claim have the correct information applied and
the Save Claim button is activated

9. Click Save Claim.  A pop up message will verify payment was saved. Click OK.

10. If Cancel is clicked, a confirmation box asks if you want to close the Patient and lose changes. If
Yes, the patient window will cancel all data entered for the active patient and close the account If an
amount is remaining on the remit, Select Patient dialog displays to choose a new patient. 

Note: A payment can be edited after Save Claim, but cannot be edited if the remit has been Posted to
ledger. 
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Post Insurance Payment to Patient Ledger

If the Insurance EOB is for a single patient payment, and the Remaining Balance in the upper
section/Remit details is zero, the Remit/EOB will need to be posted to the patient ledger and closed. If
the Remit/EOB is for multiple patients/payments, you will be prompted to select another patient and will
repeat the previous steps until the entire check is applied.

1. Print Payment (optional). Generata a report to verify all payments and how they were applied for the
active remit/check. Make any corrections/edits prior to Posting to remit.

2. Click the Post Payment button to Apply payment(s) to Patient Ledger. Payment will not be reflected
in Patient ledger until it is Posted
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Create Insurance Payment

Access from the main menu ->  Billing -> Post Insurance Payments

Select Payer/Insurance Company from Drop Down list of existing Payers in the
Insurance Company Maintenance

1. Use Drop Down to Select a Payer from the list

2. Type Check number shown on the Remit

3. Click the Create button
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Add Remit Information as shown on EOB

4. Select Billing Provider/Pay to Information from the drop down list in the Group Section

5. Enter Production/Posting/Deposit date

6. Type Check number as shown on the check, and Enter Check Date

7. Type Check amount shown on the check

8. Click the Select Patient button

Select the Patient account for Payment

9. Type the Patient account number shown on the Remit or Click on the Chart Rack button to search for
the Patient.

10. Click Select to Open the Patient account
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View of Payment Posting window with Patient Selected for Payment

When selecting a patient, the account number shown on the remit is the Claim number assigned to the
visit. When patient is opened, the grid will go directly to the claim number that was entered.

The Print Payment button will create a report listing payments applied for reference. The report can be
displayed or printed
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Reports
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Accessing the Report List

Billing menu -> Reports

Accessing the Report List

1. Click on the Billing menu. 
2. Select Reports.
3. Select the report needed.
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CPT Master Report

A report showing all CPT codes in the database for a specified year or all years combined.

CPT Master Options

1. Select the year of the CPT codes or check to see All Years' codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.
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CPT Master Sample

Sample CPT Master Report for the year 2010, sorted by Code.
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HCPCS Master Report 

A report showing all HCPCS codes in the database for a specified year or all years combined.

HCPCS Master Options

1. Select the year of the HCPCS codes or check to see All Years' codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.
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HCPCS Master Sample

Sample HCPCS Master Report for the year 2010, sorted by Code.
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ICD Master Report  

A report showing all ICD codes in the database for a specified year or all years combined.

ICD Master Options

1. Select the year of the CPT codes or check to see All Years' codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.
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ICD Master Sample

Sample ICD Master Report for the year 2010, sorted by Code.
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Custom Charges Master Report   

A report showing all custom codes in the database.

Custom Charges Master Options

1. Check if you want to show all active codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.

Custom Charges Master Sample

Sample Custom Charges Master Report with only active codes showing.
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Adjustment Code Master Report   

A report showing all adjustment codes in the database.

Adjustment Master Options

1. Check if you want to show all active codes. 
2. Select to sort by either the code or the description and the code.
3. Click Ok.

Adjustment Code Master Sample

Sample Adjustment Code Master Report with only active codes showing.
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Fee Schedule Report  

A report showing the fees set for each code, according to the selected Fee Schedule.

Fee Schedule Report Options

1. Select the desired fee schedule from the drop down. 
2. Click Ok.

Fee Schedule Report Sample

Sample Fee Schedule Report for the Default fee schedule.
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Dependency Report  

A report showing the fee schedules that have dependies on them, and the percentage that is being
calculated for each.

Dependency Report Sample

1. The base Fee Schedule. The fee schedule(s) listed below are based on the top fee schedule.
2. The calculated fee schedule, based on a percentage of the above fee schedule.
3. The percentage of #1 fee schedule to calculate the #2 fee schedule.

Practice Management 2010.3 User Manual - 373



Duplicate Report

A report showing any duplicate patients in the database. Searchable by First, Middle or Last Name,
SSN, Date of Birth, or Phone Number. 

Patient Duplicate Options

Search by any of the above criteria to find duplicate patients. 

Patient Duplicate Sample

Sample Patient Duplicate Report searching by last name, Slim.
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Payment Summary Report 

A report for showing the payments by payment type that have been entered during a specified time
period.

Payment Summary Report Options

1. Start Date and End Date: Select a date range in which to see all of the payments entered.

2. User: If wanting to run the Payment summary for a particular user, select the appropriate user from
the drop down. 

3. Exclude Posted Only: Posted Only refers to payments that were only officially posted on the current
date, but have a different (previous) Entered Date. This situation would occur if you took a pre-payment
for a patient, but did not officially post the payment to their account that day (and it remained in the
patient's Pre-Pay bank), but you did deposit the check at the bank. On the day that you do post those
charges to the patient's account, if you do not want that payment on your payment summary report
(because it has already been deposited), you can check the Exclude Posted Only box. If you would like
to see those items on your Payment summary, if you leave the Exclude Posted Only checkbox
UNchecked, you will see those items listed as Posted in their status. In addition, you will be able to see
both the Entered Date and the Posted Date, should any confusion arise.

4. Group by User: Checking this box will show payments entered by user (unless a specific user has
been selected already).
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Payment Summary Sample for all Users

1. The Date Range for the Payment Summary data.

2. Date Run: The date the report is generated

3. Indicates how the report is run: By User or All Users

4, 5 & 6:  Payment Types: Cash, Check, Credit Card, Insurance payment, etc.

7. Payment Status (Posted): Indicates that the payment was officially posted to the patient's ledger
during the date range specified. Refer to the Date Posted column for the item to see the specific post
date. This status will have both an Entered Date and a Posted Date. Depending on the circumstances,
in some cases, these 2 dates may not be the same.

8. Payment Status (Unapplied): Indicates any payments that were taken from the patient and entered,
but not officially applied toward any charges. (Will pertain to Co-Pays and Pre-Pays). This status will
show an Entered Date, but no Posted Date.
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9. Payment Status (Nonposted): Indicates any payments that have been entered into the system,
applied to charges, but have not been posted to the patient's ledger. These payments will be found in
the patient's New Charges tab of their patient account. This status will show an Entered Date, but no
Posted Date.

10. Date Entered: The date that the payment was entered and saved for a particular patient. 

11. Date Posted: The date that the payment was posted to the patient's ledger. 

12. Type: Indicates the type of payment (will be a Co-Pay, Pre-Pay, or Payment).

13. Patient Name: The patient to whom the payment was saved. 

14. Account No.: The account number for the patient indicated.

15. Reference Number: Will indicate any information that was typed in as a reference for the payment
when it was taken. (Could be a check number, credit card type, etc.) 

16. Amount: The amount of the payment that was stored for the patient indicated. 
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Production by Procedure Report (by Provider, Referring Provider and/or Facility)

A report for showing the production by code for a specified date range and searchable by Provider,
Referring Provider, and/or Facility.

Production by Procedure Report Options

Search for payments entered by Date Range, Provider, Referring Provider, and/or Facility.
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Payment Summary Sample

Sample Production by Procedure Report searching by year to date by provider Randall Oates.
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Statement Report  

This Statement manager allows reports to be run both in group or individually by patient or guarantor. 

Statement Report Options

1.  Set a minimum balance by which to send statements out. This will not allow any statement to print if
the balance is less than the minimal set here.
2.  Print batch statements by Group. 
3.  Print individual statements for a select Patient. 
4.  Print individual statements by a select Guarantor.
5.  Run batch statements alphabetically by Patient Last Name Range.
6.  Check to not include charges that are pending insurance. 
7.  Type a free text message for the statements. This message will print at the bottom of each
statement included in the process.
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8.  Adjust printing line up as need.
9.  Click Okay when finished.

Sample Statement

Sample Statement Report

New in 2010.3:

Statements now show insurance payments as "INS PYMT" and insurance adjustments as "INS ADJ".
Added insurance company name to insurance payment line items. 
Statements now preview in bulk before printing.
Statements are grouped by guarantor.
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Users may now add a note to all statements run in a batch.
Statements will not run for a provider if he is not linked to a group.
When generating batch statements, users can set the top margin between 1/10th of an inch to 3 inches.

Practice Management 2010.3 User Manual - 382



Outstanding Insurance Report  

A report showing the outstanding aging by Insurance Carrier by Provider.

Outstanding Insurance Report Options

Search for outstanding aging amounts for each carrier by Provider.

Outstanding Insurance Report Sample

Sample Outstanding Insurance Report searching by Provider.
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Credit Balance Report  

A report showing all patients with credits on their accounts.

Credit Report Sample

Sample Credit Report 
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Missed Charges Report 

A report showing any possibly missed charges within SOAPware, by Provider. The report will display 3
specific areas where charges could be being missed: 

1. Encounters: Any patients with encounters that do not have an associated billing statement will be
shown.

2. Superbills: Any patients with superbills that have never been posted will be shown. 

3. Visits: Any patients with visits that are in the patient's New Charges tab of their Patient Account that
have not been posted to the patient ledger will be shown.

(Previously known as SOAP Audit Report)

Missed Charges Report Options

Select the Provider from the drop down. 
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Missed Charges Report Sample showing Encounters without a Superbill

1. Encounters with no Superbill created. Will indicate Encounter Date, Patient Name, Account Number,
and the associated reason for the visit (Encounter Name).
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Missed Charges Report Sample showing Non-Posted Superbills and Visits

2. Superbills that have not been posted. Will indicate Superbill Date of Creation, associated Patient
Name and Account Number.

3. Missed Visits found in the New Charges tab of the patient account. Will indicate the Visit Date,
associated Patient Name and Account number.
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A/R Patient Report  

A report showing all patient A/R, searchable by selecting a specific Guarantor or Patient, Patient
Account Number, and Filtered by either Patient or Insurance amount or Both. Also filterable by Aging
Category of Current, 30, 60, 90, 120 days or All, as well as setting a particular dollar range for the Type
or Aging. 

A/R Patient Report Options

1. Create an A/R Patient report for a particular Guarantor.* 

2. Create an A/R Patient Report for a selected Patient. *

3. Create an A/R Patient Report for a particular patient, by entering their Account Number.*

4. Filter your report by any or all of the below options. These categories build on one another. The
range at the bottom will search based on the specific options that are selected in both Type and Aging.  

    Type - Patient, Insurance, Both: Select one of these options to filter. Filter just the Patient balance
or the Insurance balance or Both together. 
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    Aging - Current, 30 Days, 60 Days, 90 Days, 120 Days, All: Select an aging category to filter.
    Balance Range Start and End: The amount range entered here will apply to the options selected in
Type and Aging. For example, if you wanted to filter for any Insurance balance that has been
outstanding for 120+ days that is greater than $1,000, you would select Insurance for Type, 120 Days
for Aging and enter 1,000 for the Balance Range Start.
    NOTE: You MUST have a Start and End Balance entered to run the report. 

5. Click Okay when finished.  

* If these fields are left blank, the report engine will search the entire patient database, based on the
criteria entered at the bottom.

A/R Patient Report Sample

1. Each patient shown will indicate the Patient A/R breakdown with totals and the Insurance A/R
breakdown with Totals. 

2. For each Guarantor (Family), there will be a total of all of the dependent's Patient A/R, as well as the
totals of all of the dependent's Insurance A/R. 

3. At the bottom, there will be a total Family Balance which is a total of both the overall Patient A/R
balance and the overal Insurance A/R balance.
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A/R Carrier Report

Provides both a summary and detailed report (by patient) showing the amount of accounts receivable
pending with each insurance company (carrier).

A/R Carrier Report Options

1. Group/Provider: Select a specific provider or group by which to run the report. 

2. Breakdown by Provider: If a Group is selected from the drop down and Breakdown by Provider is
checked, the report will show the group activity, broken down by the individual providers within the
Group.

3. Show Patient Details: Will provide the specific patient charges that make up each Carrier A/R. If
you are wanting a summary report of the total A/R for each carrier, leave the box unchecked.

4. Click Ok to run the report.
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Sample Carrier A/R report, for a Group, broken down by Provider (Summary Report)

To Run the above report: 
-Select a specific Group from the Group/Provider dropdown.
-Check Breakdown by Provider.
-Leave Show Patient Details unchecked.

1. Provider/Group: The Group selected for the report.

Practice Management 2010.3 User Manual - 391



2. The Provider Summary within the Group.

3. The Insurance Company (Carrier) A/R.

4. Indicating the total amount of A/R by aging category for claims that are filed as Primary claims
with the Insurance Company.

5. Summary data for the Provider's total Carrier A/R, being held in Primary claim submissions
and Secondary claim submissions.

6. Totals for the Provider's Carrier A/R for both Primary and Secondary Claim submissions 
(when both are applicable). 

7. Percentages of the Total Carrier A/R for the Provider, broken down by aging category.
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Sample Carrier A/R Report by Group, broken down by Provider and showing Patient
Details.

To run the above report, 
-Select a Group from the Group/Provider dropdown.
-Check Breakdown by Provider.
-Check Show Patient Details.

1. Provider/Group: Indicates the Group that was selected for the report.

2. Provider: Information is broken down by Provider, and indicates who the below A/R is referencing.
(Shown due to Breakdown by Provider being checked.)
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3. Carrier: The Insurance Company Name that the A/R is referencing.

4. Patient: The Patient charge detail that is comprising the total A/R. 

     - File With:  (P for Primary or S for Secondary) Will indicate whether the insurance company above
was being filed with as Primary or Secondary for the particular procedure code.
       (For Example, the above sample report would indicate that BCBS was filed with as Primary for the
code 00120 and $90 is 120 days past due.)
     - CPT: the procedure code included in the claim
     - Date of Service: Date of Service for the procedure code
     - Submitted: The date that the procedure was last submitted/filed with insurance.
     - A/R breakdown: by Current (0-30), 31-60 Days, 61-90 Days, 91-120 Days, and Over 120 Days.

5. Total: Provides the Total Carrier A/R for the patient, with the specific Insurance Company listed
above.
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Sample Carrier A/R report for a Single Provider with No Patient Details (Summary
Report)

To Run the above report: 
-Select a specific Provider from the Group/Provider dropdown.
- Leave other checkboxes blank (unchecked).

1. Provider/Group: The Provider selected for the report.

Practice Management 2010.3 User Manual - 395



2. The Insurance Company (Carrier)

3. Indicating the total amount of A/R by aging category for claims that are filed as Primary claims
with the Insurance Company.

4. Indicating the total amount of A/R by aging category for claims that are files as Secondary
claims with the Insurance Company. 

5. Summary data for the Provider's total Carrier A/R, being held in Primary claim submissions
and Secondary claim submissions.

6. Totals for the Provider's Carrier A/R for both Primary and Secondary Claim submissions. 

7. Percentages of the Total Carrier A/R for the Provider, broken down by aging category.
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Sample Carrier A/R report by Provider, with Patient Detail

To run the above report, 
-Select a Provider from the Group/Provider dropdown.
-Leave Breakdown by Provider unchecked.
-Check Show Patient Details.

1. Provider/Group: Indicates the Provider that was selected for the report.
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2. Carrier: The Insurance Company Name that the A/R is referencing.

3. Patient: The Patient charge detail that is comprising the total A/R. 

     - File With:  (P for Primary or S for Secondary) Will indicate whether the insurance company above
was being filed with as Primary or Secondary for the particular procedure code. (For Example, the
above sample report would indicate that BCBS was filed with as Primary for the code 00120 and $90 is
120 days past due.)
     - CPT: the procedure code included in the claim
     - Date of Service: Date of Service for the procedure code
     - Submitted: The date that the procedure was last submitted/filed with insurance.
     - A/R breakdown: by Current (0-30), 31-60 Days, 61-90 Days, 91-120 Days, and Over 120 Days.

5. Total: Provides the Total Carrier A/R for the patient, with the specific Insurance Company listed
above.
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End of Day Report   

Report the charges, payments and adjustments entered each day, filterable by User or Provider. 

End of Day Report Options

1. Select the date to view the transactions that took place on that day. 
2. View transaction data by User or Provider.
3. Select from the dropdown whether you want data broken down and displayed by User first and then
by Provider, or by Provider first, and then by User. Or leave blank to show all.
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End of Day Report Sample

Details shown on End of Day Reporting:

1. Patient Name and date of service.
2. Procedure and Charge for procedure.
3. Personal payments. 
4. Insurance payments.
5. Adjustments on account.
6. Co Pay taken for patient. The gray shaded grid indicates that the co pay was received but not yet
applied to the patient account and posted to ledger. 
7. Totals by provider.
8. Grand total.
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End of Month Report  

Aging report of number of procedures, total charges, payments and adjustments by provider/group per
month

1. Select month to report.
2. Filter by Group/Provider. Leave blank to show all, select individual provider or group.
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Details shown on report 

By Provider(s) within a group:
1. Month to date and year to date number of procedures/units
2. Month to date and year to date number of charges
3. Month to date and year to date number of  payments 
4. Month to date and year to date number of adjustments.  

Total Summary for group:
1. Month to date and year to date number of procedures/units
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2. Month to date and year to date number of charges
3. Month to date and year to date number of  payments 
4. Month to date and year to date number of adjustments.  
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End of Year Report 

Report number of procedures, total charges, payments and adjustments by provider/group per year.

1. Select year to report
2. Filter by Group/Provider. Leave blank to show all, select individual provider or group
3. Choose to run by date of service or by date posted to ledger
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Example of End of Year report by date of service by Provider

1. Accounts receivable by month
2. Total procedures, charges, payments and adjustments broken down by month
3. Year to date totals  
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Security Manager/Audit Log
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Security Manager

How to view and monitor user activity. 

SOAPware menu -> Security Manager

Accessing the Security Manager

1. Go to the SOAPware menu. 
2. Select Security Manager. 
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Viewing system activity

The Audit Log is designed to show the specific activity throughout the system and allow it to be
displayed by Date, User, Location in the system, IP Address, Section in SOAPware, or by Patient. It will
show the basic activity that was done, and if an item is clicked on, the Audit Details will show the
specific changes that were made. 

1. Query the specific information that is needed. 
2. A display of the line item activity performed.
3. When a line item is selected, the Audit Details will show the specific activity performed and exactly
what the changes were. 
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